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保証期間

当社は本製品について、当社の認定代理店による出荷の日から 1 年間、その素材および製造工程に欠陥がないことを保

証します。本保証期間中、かかる製品に欠陥があることが判明した場合、当社は、当社の判断にて、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、または当該欠陥製品と交換に代替品を提供します。当社が保証遂行のた
めに使用する部品、モジュール、および代替品は、新品の場合もあれば、新品同様の性能を持つ再生品の場合もありま
す。交換後、当社が引き取った部品、モジュール、および製品はすべて当社の所有物となります。

お客様が本保証に基づくサービスを受けるには、適用保証期間が満了する前に、当該欠陥について当社に通知し、サー
ビス実施に関する適切な手配を行う必要があります。お客様には、当該欠陥製品を梱包していただき、送料元払いにて当
社指定のサービス受付センターに送付していただきます。製品をお客様に返送する際、返送先が当社サービス受付セン
ターの所在国と同一国内にある場合には、当社がその返送費用を負担するものとします。上記以外の場所に返送される
製品については、すべての発送費用、関税、税、およびその他の費用を支払う責任はお客様が負うものとします。

製品の不適切な使用または整備点検の不足によって生じた欠陥、障害、または損傷は、本保証の対象外です。当社は、
次の事項については、本保証に基づくサービスを提供する義務を負わないものとします。a）当社担当者以外の者による

本製品の設置、修理または整備の実施から生じた損傷に対する修理。b）不適切な使用または互換性のない機器への接

続から生じた損傷に対する修理。c）当社製以外のサプライ用品の使用により生じた損傷または動作不良に対する修理。

d）本製品が改造または他の製品と統合された場合において、かかる改造または統合の影響により当該本製品の整備の

時間または難易度が増加した場合の当該本製品に対する整備。

本保証は、明示であるか黙示であるかを問わず他のあらゆる保証の代わりに、本製品に関して当社がお客様に対して提
供するものです。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性についての一切の黙示保
証を否認します。不具合のある製品を修理または交換するという当社の責任行為は、本保証の義務違反に対してお客様
に提供される唯一の救済手段です。当社および当社代理店は、間接的、限定的、偶発的、または派生的な損害について
は、かかる損害の可能性を事前に通知されていたか否かにかかわらず、一切責任を負わないものとします。
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保証期間

当社は、本ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムのエンコード
が、材料および製造工程において欠陥がないことを、出荷から 3 か月の期間にわたって保証します。当該保証期間中に

かかるメディアまたは記録状態に欠陥があることが判明した場合、テクトロニクスは、欠陥メディアと交換に代替品を提供
します。ソフトウェア製品を提供する目的で使用されているメディアの欠陥を除き、本ソフトウェア製品は「あるがまま」の形
で提供され、明示的と黙示的のどちらも含め、いかなる形での保証も適用されません。当社は、ソフトウェア製品の中に含
まれている機能がお客様の要求を満たすこと、プログラムの動作が中断されないこと、またはエラーが皆無であることの
いずれも保証しません。

本保証に基づくサービスを受けるため、お客様は、当該保証期間の満了前に欠陥をテクトロニクスに通知します。お客様
から通知を受けた後、材質の欠陥または作業工程の欠陥の影響を受けていない代品を当社が妥当な期間のうちに提供
できない場合は、お客様は本ソフトウェア製品に関するライセンスを終了させ、本ソフトウェア製品とそれに関連するあらゆ
る資材を返却することにより、お客様が既に支払った料金の払い戻しを受けることができます。

本保証は、明示であるか黙示であるかを問わず他のあらゆる保証の代わりに、本製品に関して当社がお客様に対して提
供するものです。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性についての一切の黙示保
証を否認します。当社がこの保証を履行しなかった場合は、当社は欠陥メディアの交換、またはお客様が既に支払った金
額の払い戻しを行う責任を負いますが、それは保証不履行に対する唯一の排他的な賠償です当社および当社代理店
は、間接的、限定的、偶発的、または派生的な損害については、かかる損害の可能性を事前に通知されていたか否かに
かかわらず、一切責任を負わないものとします。

[W9b – 15AUG04]



目次

ライセンス契約 ................................................................................................................................................. v
安全性に関する重要な情報 ......................................................................................................................... ix

安全にご使用いただくために .................................................................................................................. ix
安全に保守点検していただくために ...................................................................................................... xi
本マニュアル内の用語 ............................................................................................................................. xi
本機に関する用語 .................................................................................................................................... xi
本製品の記号 ........................................................................................................................................... xii

適合性に関する情報 .................................................................................................................................... xiii
EMC 適合性 ............................................................................................................................................... xiii
安全性 ........................................................................................................................................................ xiv
環境基準に対する適合性 ...................................................................................................................... xv

まえがき .......................................................................................................................................................... xvii

設置
設置の前に ................................................................................................................................................. 1
動作条件 ...................................................................................................................................................... 1
コントロールおよびコネクタ ...................................................................................................................... 2

側面のコネクタ ...................................................................................................................................... 2
フロント・パネル・コントロールおよびコネクタ ................................................................................. 3
オプション・カード用コネクタ ............................................................................................................... 4

MTS4SAV3 型スタンドアロン・システムの設置 ...................................................................................... 6
システム要件 ......................................................................................................................................... 6
オプション ESB 型および ESE 型のシステム要件 .......................................................................... 7
設置手順 ................................................................................................................................................ 7

電源投入方法 ........................................................................................................................................... 12
電源の供給 ......................................................................................................................................... 12
電源の投入 ......................................................................................................................................... 12
キーボードの取り外し ........................................................................................................................ 13

電源切断方法 ........................................................................................................................................... 13
VLC Media Player のインストール ............................................................................................................ 14
ネットワーク構成 ...................................................................................................................................... 14

ネットワークのトラブルシューティング ............................................................................................ 14
基本的な要件 ...................................................................................................................................... 15
IP パラメータ ........................................................................................................................................ 15
一般的なトラブルシューティング手順 ............................................................................................ 17

MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル i



NIC 帯域幅制限 .................................................................................................................................. 21
ネットワーク情報の入手先 ............................................................................................................... 21

操作
製品の説明 ............................................................................................................................................... 23
ソフトウェア・アプリケーション ................................................................................................................ 24
アプリケーションの起動 .......................................................................................................................... 26
デュプレックス操作 .................................................................................................................................. 27

ループバックのセットアップ .............................................................................................................. 27
インタフェース・カードのステータス LED ............................................................................................... 28

手順
マルチプレクサの使用 ............................................................................................................................ 29

マルチプレクサを使用した新規ストリームの作成 ....................................................................... 29
トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）の使用 ...................................... 42
PES Analyzer の使用 ................................................................................................................................. 46
T-STD Buffer Analyzer の使用 ................................................................................................................... 49
ES Analyzer の使用 ................................................................................................................................... 54
TSCA FlexVuPlus™ ディスプレイ ............................................................................................................. 57
複数入力のモニタ .................................................................................................................................... 61

アクセサリ
スタンダード・アクセサリ ......................................................................................................................... 63
オプションとアップグレード ..................................................................................................................... 64

オプション ............................................................................................................................................. 64
MTS4KUP アップグレード・キット ....................................................................................................... 65

MTS4000 型のシステム・リカバリ
オペレーティング・システムのリストア .................................................................................................. 69

機器のハード・ディスクからオペレーティング・システムをリストアする ................................... 69
OS リストア DVD を使用してオペレーティング・システムをリストアする ................................... 70

MTS4000 システム・アプリケーションのインストール ......................................................................... 70

ユーザ・メンテナンス
一般的な注意事項 .................................................................................................................................. 73

目次  

ii MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル



予防保全 .................................................................................................................................................... 73
外部のクリーニング ........................................................................................................................... 73
キーボードのクリーニング ................................................................................................................ 73

問題が発生した場合 ............................................................................................................................... 74
ソフトウェアに関する問題 ................................................................................................................. 74
ハードウェアに関する問題 ............................................................................................................... 75
TSCAP P1 アイコンのリストア ............................................................................................................ 75

修理のための機器の返送 ..................................................................................................................... 75

 目次

MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル iii



目次  

iv MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル



ライセンス契約

重要 - 機器を操作する前にお読みください

本ソフトウェアは、Tektronix, Inc. からのライセンスに基づき提供されます。本プログラムの保有期間が 30 日を超え

た場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本ライセンス条項を承諾したも
のとみなされます。

同梱のソフトウェア・ライセンス契約書をよくお読みください。本ライセンス条項にご同意頂けない場合、最寄りの
テクトロニクス営業所までお早めにお問い合わせの上、返品に関する手配をご用命ください。

テクトロニクス・ソフトウェア・ライセンス契約書

機器内に搭載されたプログラムも含む本プログラムは、本契約条項を条件として提供されます。本プログラムの
保有期間が 30 日を超えた場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本契約

条項を承諾したものとみなされます。これらの条項にご同意頂けない場合、未使用のプログラムおよび関連資料
をテクトロニクスへ至急ご返送ください。お支払い頂いたライセンス料金を全額払い戻します。(機器の一部として

コード化、または機器に内蔵されているプログラムを返却する場合の詳細については、Tektronix の最寄りの販売

代理店にお問い合わせください。)

定義：「テクトロニクス」とは、機器を供給している米国オレゴン州法人 Tektronix, Inc. または他の国もしくは地域の

テクトロニクス・グループ法人を意味します。

「お客様」とは、このプログラムを発注した個人または組織を意味します。

ライセンス：お客様は、次の行為を行うことができます。

1. 同時に 1 台の機器でのみ本プログラムを使用すること。

2. 本プログラムがフローティング・ユーザ・ライセンスに基づき提供された場合には、正規ユーザが複数台の機
器上で本プログラムを使用することが許可されるものとします。ただし、正規ユーザの総数がライセンスに規
定の同時使用ユーザ総数を超えないことを条件とします。

3. 1 台の機器上で使用することを条件として、本プログラムを改変し、または他のプログラムと併合すること。

4. アーカイブまたはバックアップの目的で本プログラムを複製すること。ただし、かかる複製物がどの時点にお
いても 1 部を超えて存在しないことを条件とします。本プログラムがフローティング・ユーザ・ライセンスに基づ

き提供された場合、正規ユーザが使用することを条件として、複数台の機器上に本プログラムをコピーするこ
とができます。

お客様は、自己が作成した本プログラムの各複製物に対し、テクトロニクスから受領した本プログラムと同一の著
作権表示および権利制限事項を明示する必要があります。

お客様は、次の行為を行うことができません。

1. フローティング・ユーザ・ライセンスまたは別途のサイト・ライセンスに基づく場合を除き、同時に複数台の機
器上で本プログラムを使用すること。

2. テクトロニクスから書面による事前の許可を得ることなく、第三者もしくは外部の組織に対し本プログラムを譲
渡すること、またはお客様が所属している法人に対し本プログラムを譲渡すること。ただし、本プログラムが
搭載されている機器を譲渡する場合を除きます。

3. 管轄権を有する米国または他国政府の法令により輸出または再輸出が制限されている国に対し、必要とさ
れる場合の米国商務省輸出管理局およびかかる他国政府機関の事前の許可なく、本プログラム、関連資料
またはこれらの直接的産物を直接または間接的に輸出または再輸出すること。
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4. オブジェクトコード形式の本プログラムについて、目的の如何を問わず逆コンパイルまたは逆アセンブルを行
うこと。

5. 本プログラムの付属資料を複製すること。

1 台の機器に搭載された本プログラムが他の機器に移転されることなく 1 台以上の他の機器をローカルまたはリ

モートで支援する場合、かかる他の機器は、「1 台の機器」の定義に含まれるものとします。本プログラムを複数

の機器に個別に搭載してそれぞれをローカルで稼動させるという運用形態をとる場合、本プログラムを使用する
機器ごとに、またはフローティング・ユーザ・ライセンスに基づく正規の同時使用ユーザごとに別個のライセンスが
必要となります。

本プログラムおよびそのすべての複製物（本プログラムまたはかかる複製物が存在するメディアを除きます）に係
る権利は、テクトロニクスに、またはテクトロニクスが各ライセンス権を取得した第三者に帰属します。

お客様は、本プログラムの保有もしくは使用または本ライセンスについて本契約発効以後に課されるすべての税
金を期限までに支払い、かかる税金につき必要とされるすべての届出を行います。

本プログラムのうちお客様により改変された部分、または他のプログラムと併合された部分に対しても、本契約条
項が適用されます。

本プログラムが米国政府機関により、または当該機関のために取得された場合、本プログラムは、私企業の費用
負担にて開発されたコンピュータ・ソフトウェアとみなされ、本契約におけるライセンス許諾は、調達関係の適用法
令にて定義されるとおり、本プログラムおよび関連資料における制限された権利をお客様に許諾することとして解
釈されます。

本契約条項により明示的に許可された場合を除き、お客様は本プログラムを使用、複製、改変、併合、または第
三者に譲渡することはできません。

本プログラムの複製物、改変物、または併合部分が譲渡された場合、本契約において許諾されたライセンスは、
自動的にただちに解約されます。

期間：本契約において許諾されたライセンスは、お客様が本契約を承諾した時点を以て発効し、本契約の規定に
より解約されるまで有効に存続します。お客様は、テクトロニクスに書面にて通知することにより、本ライセンスを
いつでも解約することができます。お客様が本契約条項に違反した場合において、テクトロニクスまたはテクトロ
ニクスが各ライセンス権を取得した第三者からその旨の通知があった日から 30 日以内にかかる違反が是正され

なかったときは、テクトロニクスまたはかかる第三者は、本ライセンスを解約することができます。本契約の解約
後、お客様は、本プログラムおよび関連資料を、形態の如何を問わずその複製物のすべてと共に、ただちにテク
トロニクスに返還し、または破棄します。

限定保証：テクトロニクスは、本プログラムが提供されたメディアおよび本プログラムのメディアへの記録状態に材
質および製造上の欠陥がないことを、発送後 3 か月間保証します。当該保証期間中にかかるメディアまたは記録

状態に欠陥があることが判明した場合、テクトロニクスは、欠陥メディアと交換に代替品を提供します。本プログラ
ムが提供されたメディアに関する場合を除き、本プログラムは、明示または黙示の何等の保証もなく現状のまま
で提供されます。テクトロニクスは、本プログラムの機能がお客様の要求を満たすこと、および本プログラムに動
作の中断または誤動作が全くないことについては保証しません。

本保証に基づくサービスを受けるため、お客様は、当該保証期間の満了前に欠陥をテクトロニクスに通知しま
す。その後合理的な期間内にテクトロニクスが材質および製造上の欠陥のない代替品を提供することができなか
った場合、お客様は、かかる本プログラムのライセンスを解約することができ、支払済みライセンス料があればそ
の払い戻しを受けて本プログラムおよび関連資料を返却することができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、プログラムに関してテクトロニクスがお客様
に対して提供するものです。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性につい
ての一切の黙示保証を否認します。当社がこの保証を履行しなかった場合は、当社は欠陥メディアの交換、また
はお客様が既に支払った金額の払い戻しを行う責任を負いますが、それは保証不履行に対する唯一の排他的な
賠償です。

責任の制限：お客様による本プログラムの保有または使用に起因または関係する間接損害、特別損害、付随的
損害、および派生損害については、テクトロニクスおよびテクトロニクスがライセンス権を取得した第三者は、かか
る損害が発生し得る旨の事前通知を受けていた場合といえども、いかなる責任をも負いません。
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第三者の免責事項：別途明示的に合意した場合を除き、テクトロニクスがライセンス権を取得した第三者は、本プ
ログラムにつきいかなる保証も行わず、本プログラムの使用につきいかなる責任も負わず、また、本プログラムに
関する支援または情報を提供するいかなる義務をも負いません。

一般条項：本契約書は、本プログラムの使用、複製、および譲渡に関する当事者間の完全なる合意事項を構成
します。

お客様は、テクトロニクスの事前の書面による同意なく、本契約および本契約において許諾されたライセンスを第
三者に譲渡することができません。

本契約および本契約において許諾されたライセンスは、米国オレゴン州法令に準拠します。

本契約または本契約において許諾されたライセンスにつきご不明な点がございましたら、最寄りのテクトロニクス
営業所までお問い合わせください。

ビデオ・テスト・シーケンスに対する追加ライセンス供与：ソフトウェア製品には何らかのテスト・パターン、ビデオ・
テスト・シーケンス、およびビデオ・クリップ（合わせて「ビデオ・テスト・シーケンス」）が含まれている場合がありま
す。その場合、ビデオ・テスト・シーケンスに関するお客様の権利は以下の条項のとおりです。

お客様はビデオ・テストの実行に伴い、ビデオ・テスト・シーケンスの使用、複製、改変、ならびに個々のビデオ・テ
スト・シーケンスの表示もしくは複製の配布を行うことができます。

お客様は、以下のいかなる行為についても許諾されていません。

1. お客様はテクトロニクスからの書面による事前の許可を得ることなく、ビデオ・テスト・シーケンスの集合体に
ついて、かかるビデオ・テスト・シーケンスを含む元の機器を売却する場合を除き、配布することはできませ
ん。

2. お客様は、ビデオ・テスト・シーケンスの第三者による配布を許可することはできません。

3. お客様は、本ビデオ・テスト・シーケンスの複製を単独で販売、ライセンス供与、もしくは配布してはなりませ
ん。またかかるビデオ・テスト・シーケンスが製品やサービスの価値の主体をなす場合は、いかなる集合体、
製品、サービスの一部としても販売、ライセンス供与、もしくは配布することはできません。

お客様は、お客様によって改変されたビデオ・テスト・シーケンスの使用もしくは配布の結果生じたいかなる申立
てもしくは訴訟（弁護士費用を含む）に対してもテクトロニクスを免責し、補償し、また弁護しなければなりません。

お客様の製品やサービスにかかるビデオ・テスト・シーケンスの複製を含める場合は有効な著作権表示を含めな
ければなりません。
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安全性に関する重要な情報

このマニュアルには、操作を行うユーザの安全を確保し、製品を安全な状態に保つために順守しなければならな
い情報および警告が記載されています。

本機の点検にあたっては「安全にご使用いただくために」に続く「Service safety summary」を参照して、事故防止に

つとめてください。

安全にご使用いただくために

製品は指定された方法でのみご使用ください。人体への損傷を避け、本製品や本製品に接続されている製品の
破損を防止するために、安全性に関する次の注意事項をよくお読みください。すべての指示事項を注意深くお読
みください。必要なときに参照できるように、説明書を安全な場所に保管しておいてください。

該当する地域および国の安全基準に従ってご使用ください。

本製品を正しく安全にご使用になるには、このマニュアルに記載された注意事項に従うだけでなく、一般に認めら
れている安全対策を徹底しておく必要があります。

本製品は訓練を受けた専門知識のあるユーザによる使用を想定しています。

製品のカバーを取り外して修理や保守、または調整を実施できるのは、あらゆる危険性を認識した専門的知識の
ある適格者のみに限定する必要があります。

使用前に、既知の情報源と十分に照らし合わせて、製品が正しく動作していることを常にチェックしてください。

本製品は危険電圧の検出用にはご利用になれません。

危険な通電導体が露出している部分では、感電やアーク・フラッシュによってけがをするおそれがありますので、
保護具を使用してください。

本機を大きなシステムの下で使用する場合、そのシステムを構成する他のパーツにアクセスしなければならない
場合があります。他のシステムの操作に関する警告や注意事項については、その製品コンポーネントのマニュア
ルにある安全に関するセクションをお読みください。

本機をシステムの一部として使用する場合、そのシステムの安全性についてはシステムの構築者が責任を負うも
のとします。

火災やけがを避けるには

適切な電源コードを使用してください： 電源コードは本機に適した仕様で、使用国の基準を満たすもののみを使

用してください。他の製品の電源コードは使用しないでください。

本製品を接地してください： 本製品の電源コードには接地用のグランド線が付いています。感電を避けるため、グ

ランド線をアースに接続する必要があります。本製品の入出力端子に接続する前に、製品が正しく接地されてい
ることを確認してください。電源コードのグランド接続を無効にしないでください。

電源の切断： 本製品は、電源スイッチを使用して電源ソースから切断します。スイッチの位置については、使用説

明書を参照してください。 電源スイッチの操作が困難な場所に本機器を設置しないでください。ユーザが緊急時

にすぐに操作できる場所に設置する必要があります。

すべての端子の定格に従ってください： 発火や感電の危険を避けるために、本製品のすべての定格とマーキン

グに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参照してください。

コモン端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

本製品の測定端子は、AC 電源、カテゴリ II、 III、および IV 回路には使用できません。
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カバーを外した状態で動作させないでください： カバーやパネルを外した状態やケースを開いたまま動作させない

でください。危険性の高い電圧に接触してしまう可能性があります。

露出した回路への接触は避けてください： 電源が投入されているときに、露出した接続部分やコンポーネントに触

れないでください。

故障の疑いがあるときは使用しないでください： 本製品に故障の疑いがある場合には、資格のあるサービス担当

者に検査を依頼してください。

製品が故障している場合には、使用を停止してください。製品が故障している場合や正常に動作していない場合

には、製品を使用しないでください。安全上の問題が疑われる場合には、電源を切って電源コードを取り外してく
ださい。誤って使用されることがないように、問題のある製品を区別できるようにしておいてください。

使用する前に、製品の外観に変化がないかよく注意してください。ひび割れや欠落した部品がないことを確認して

ください。

指定された交換部品のみを使用するようにしてください。

適切なヒューズを使用してください： 本製品用に指定されたヒューズ・タイプおよび定格のみを使用してください。

保護メガネを着用してください： 強力な光線またはレーザー照射にさらされる危険性がある場合は、保護メガネを

着用してください。

湿気の多いところでは動作させないでください： 機器を寒い場所から暖かい場所に移動する際には、結露にご注

意ください。

爆発性のガスがある場所では使用しないでください：

製品の表面を清潔で乾燥した状態に保ってください： 製品の清掃を開始する前に、入力信号を取り外してくださ

い。

適切に通気してください： ユーザ・マニュアルの設置手順を参照し、十分な換気を確保してください。

製品には通気用のスロットや開口部があります。その部分を覆ったり、通気が妨げられたりすることがないように

してください。開口部には異物を入れないでください。

安全な作業環境を確保してください： 製品は常にディスプレイやインジケータがよく見える場所に設置してくださ

い。

キーボードやポインタ、ボタン・パッドは正しく使用し、長時間の連続使用は避けてください。キーボードやポインタ

の使用方法を誤ると、身体に深刻な影響が及ぶ可能性があります。

作業場が該当する人間工学規格を満たしていることを確認してください。ストレスに由来するけががないように、

人間工学の専門家に助言を求めてください。

製品を持ち上げたり運んだりする作業は慎重に行ってください。本製品には持ち運び用のハンドルが取り付けら

れています。
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安全に保守点検していただくために

「安全に保守点検していただくために」のセクションには、製品の保守点検を安全に行うために必要な詳細な情報

が記載されています。資格のあるサービス担当者以外は、保守点検手順を実行しないでください。保守点検を行
う前には、この「安全に保守点検していただくために」と「安全にご使用いただくために」をお読みください。

感電を避けるため、： 露出した接続部には触れないでください。

保守点検は単独で行わないでください。： 応急処置と救急蘇生ができる人の介在がない限り、本製品の内部点

検や調整を行わないでください。

電源を切断してください。： 保守点検の際にカバーやパネルを外したり、ケースを開く前に、感電を避けるため、製

品の電源を切り、電源コードを電源コンセントから抜いてください。

電源オン時の保守点検には十分注意してください。： 本製品には、危険な電圧や電流が存在している可能性が

あります。保護パネルの取り外し、はんだ付け、コンポーネントの交換をする前に、電源の切断、バッテリの取り
外し（可能な場合）、テスト・リードの切断を行ってください。

修理後の安全確認。： 修理を行った後には、常にグランド導通と電源の絶縁耐力を再チェックしてください。

本マニュアル内の用語

本マニュアルでは以下の用語を使用しています。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本機やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本機に関する用語

本機では次の用語を使用します。

■ 危険： ただちに人体や生命に危険をおよぼす可能性があることを示します。

■ 警告： 人体や生命に危険をおよぼす可能性があることを示します。

■ 注意： 本製品を含む周辺機器に損傷を与える可能性があることを示します。
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本製品の記号

製品にこの記号が表記されているときは、マニュアルを参照して、想定される危険性とそれらを回避す
るために必要な行動について確認してください。（マニュアルでは、この記号はユーザに定格を示すた
めに使用される場合があります）。

本製品では、次の記号を使用します。
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適合性に関する情報

このセクションでは、本製品が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC 適合性

EC 適合宣言 - EMC
Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A

■ IEC 61000-4-2. Electrostatic discharge immunity

■ IEC 61000-4-3. RF electromagnetic field immunity  4

■ IEC 61000-4-4. Electrical fast transient / burst immunity

■ IEC 61000-4-5. Power line surge immunity

■ IEC 61000-4-6. Conducted RF immunity

■ IEC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. 高調波エミッション

EN 61000-3-3. Voltage changes, fluctuations, and flicker

Mfr. Compliance Contact.
Tektronix, Inc. PO Box 500, MS 19‐045
Beaverton, OR 97077, USA
www.tek.com

オーストラリア／ニュージーランド適合宣言 - EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A, in accordance with EN 61326-1.

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。
2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。
3 ここに挙げた各種 EMC 規格に確実に準拠するには、高品質なシールドを持つインタフェース・ケーブルが必要です。
4 MTS4000 型は、オプション QB2 型（QAM Annex B）を除く、すべてのインタフェース・カードの構成で上記整合規格要件に適合します。本オプションに適

用される個別の RF 電磁界イミュニティの条件は次のとおりです。QAM-256 コンスタレーション信号を復調する際、QAM Annex B カードは IEC
61000-4-3 の EN 61326-1 表 1 の規定よりも低レベルの放射電磁界の影響を受けます。これは、同調入力周波数よりも 44 MHz（QAM チューナーの局

部発信周波数）高い、非常に狭い周波数帯域でのみ生じます。このモードにおける QAM 復調器の高感度が原因で、RF ロックが失われたり、ストリ

ーム・エラーが生じることがあります。最高の性能を得るために、ケーブル・アダプタは使用せずに、高品質のシールド・ケーブルのみを使用して
MTS4000 型に接続してください。
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安全性

This section lists the safety standards with which the product complies and other safety compliance information.

EC 適合宣言 - 低電圧

Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2006/95/EC.

■ EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

米国の国家認定試験機関のリスト

■ UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

カナダ規格

■ CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use
– Part 1: General Requirements.

その他の基準に対する適合性

■ IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:
General Requirements.

Equipment type
Test and measuring equipment.

Safety class
Class 1 – grounded product.

Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

■ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

■ Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.

■ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

■ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

適合性に関する情報  
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汚染度

汚染度 2（IEC 61010-1 の定義による）。注：乾燥した屋内でのみ使用できます。

IP 定格

IP20 (IEC 60529 で定義)。

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

■ Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.

■ Measurement Category III. For measurements performed in the building installation.

■ Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

主電源過電圧カテゴリ定格

過電圧カテゴリ II（IEC 61010-1 の定義による）

環境基準に対する適合性

This section provides information about the environmental impact of the product.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Mercury notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due to
environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling Central
Web page (www.eiae.org) for disposal or recycling information.

 適合性に関する情報
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まえがき

このマニュアルでは、当社の MTS4000 型 MPEG テスト・システムの機能と使用方法について説明します。このマニ

ュアルでは、次の規則に従って製品名を表します。

■ MTS4000 型機器：MTS4000 型のみを表します。

■ MTS4000 型システム：MTS4000 型および MTS4SAV3 型に該当する情報です。

■ MTS4SAV3 型スタンドアロン・システム：MTS4SAV3 型のみを表します。

主な特長

■ 業界最速の解析エンジンにより、次世代 DTV および IPTV システム／サービスの解析、RAD、評価、配備、お

よび診断に要する時間を大幅に短縮できます。

■ MPEG、DVB、ATSC、ISDB、および ISDB-TB（ブラジル）、さらにこれらの規格の地上波、ケーブル、衛星、および

地域別の放送方式のための特定の SI など、幅広い規格がサポートされています。

■ さまざまなインタフェースと解析機能。トランスミッション・リンク（RF または IP レイヤ）やコンテンツ処理（TS レ
イヤ）など、あらゆるネットワーク環境で発生する問題を診断するために必要な接続が実現します。

■ IP v 4 および IP v 6 の両ネットワークに接続。IGMP および MLD マルチキャスト・プロトコルを使用するネットワ

ークも含まれます。

■ 固定ビット・レート（CBR および VBR  1）ストリームの解析。

■ クロスレイヤ障害解析やログ機能が内蔵されているため、1 つの機器で障害診断を行うことができ、トラブル

シューティング時の調査にかかる時間を短縮できます。

■ 再生機能により、パラメトリック機能を伴うスティミュラスが提供され、ネットワークや被測定デバイス（DUT）の
動作を評価するための IP マルチセッション・レプリケーションが提供されます。

■ CaptureVu® テクノロジ。間欠的で複雑な問題をデバッグするために、システム・イベントをリアルタイムおよび

事後に取り込んで解析します。

■ プログラムを中心とする革新的なユーザ・インタフェース。誰でも専門家の判断を下すことができます。

■ 多重ストリームおよび ES のコンプライアンスをチェックする H265（HEVC）および H.264 バッファ解析。H265
（HEVC）および H.264 コンテンツが含まれるトランスポート・ストリームの作成と解析に使用できる強力なツー

ル群が提供されます。

■ ネットワーク配信と圧縮の結果に起因する問題の切り分けを支援するビデオとオーディオの品質解析。

■ マルチ入力モニタ。

マニュアル

このマニュアルでは、MTS4000 型システムの設置と基本的な操作方法について説明します。また、この製品には

以下のマニュアルがあります。

1 VBR ストリームでは一部のタイミング関連の測定ができない場合があります。
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タイトル 内容 場所

MTS4000 型クイック・スタート・ユーザ・

マニュアル（071-2970-xx 英語、077-0665-
xx 簡体字中国語、077-0666-xx 日本語、

077-0657-xx ロシア語）

テスト・システムの設置方法および使用
方法の概要を説明します。

MTS4000 型アナライザ・アプリケーショ

ン・ユーザ・マニュアル（077-0622-xx）
アナライザ・アプリケーション（TSCA、
PES アナライザ、T-STD バッファ・アナラ

イザ、および ES アナライザ）の操作に

ついて説明します。

MTS4000 型ゼネレータ・アプリケーショ

ン・ユーザ・マニュアル（077-0623-xx）
ゼネレータ・アプリケーション（マルチプ
レクサ、MPEG Player、TS エディタ、シー

ムレス化機能、トランスポート・ストリー
ム・カッタ、およびスクリプト・パッド）の
操作について説明します。

MTS4000 型 Carousel アプリケーション・

ユーザ・マニュアル（077-0624-xx）
カルーセル・アナライザおよびカルーセ
ル・ゼネレータ・アプリケーションの操作
について説明します。

MTS4000 型 MPEG テスト・システム仕様

および性能検査に関するテクニカル・リ
ファレンス（077-0626-xx）

製品仕様と検査手順についての一覧を
提供します。

MTS4000 型リリース･ノート（077-0627-
xx）

テスト・システムに関する既知の問題に
ついて説明します。

MTS4EAV7 HEVC / AVC Video and
Compressed Audio Analyzer User Manual
（071-1134-xx）

MTS4EAV7 アプリケーション・ソフトウェ

アの操作方法を説明します。

MTS4CC エレメンタリ・ストリーム・コンプ

ライアンス・チェッカ・ユーザ・マニュア
ル（071-2075-xx）

MTS4CC アプリケーション・ソフトウェア

の操作方法を説明します。

PQA600C および PQASW ピクチャ・クオ

リティ・アナライザ・クイック・スタート・ユ
ーザ・マニュアル（077-1137-xx）

PQA アプリケーション・ソフトウェアの操

作方法を説明します。

VQS1000 ビデオ・クオリティ・ソフトウェ

ア・クイック・スタート・ユーザ・マニュア
ル（077-0489-xx）

VQS1000 アプリケーション・ソフトウェア

の操作方法を説明します。

ユーザ・マニュアルは Tektronix Web サイト www.tek.com/downloads.

次の URL を使用すると、次の標準機関のホームページにアクセスできます（一覧にある URL はこのマニュアルの

作成時点で有効な URL です）。

■ MPEG-2 規格（国際標準化機構）- www.iso.org/

■ DVB 規格（欧州電気通信標準化機構）- www.etsi.org/

■ ATSC 規格（高画質テレビ・システム委員会）- www.atsc.org/
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本マニュアルで使用する表記規則

このマニュアルでは、次のようなマークが使用されています。

実行順序 フロントパネル
の電源

電源の接続 ネットワーク PS2 SVGA USB

 まえがき
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設置

設置の前に

機器を受け取ったら、次の手順で検査を実行してください。

1. 輸送用段ボール箱に、機器破損の可能性を示す外部損傷がないかどうかを検査します。

2. 輸送用段ボール箱から MTS4000 型機器を取り出します。

3. 輸送中に機器に損傷がなかったかどうかを調べます。機器の外側に傷や衝撃を受けた痕跡がないことを確
かめてください。出荷に先立ち、機器は機械的損傷の有無を徹底的に検査されています。

注： 輸送が必要になった場合に機器を再び梱包できるように、段ボール箱や梱包材は保管しておいてくださ
い（修理のための機器の返送(75 ページ)を参照）。

4. 標準アクセサリおよびご注文のオプショナル・アクセサリがすべて届いていることを確かめてください（アクセ
サリ(63 ページ)を参照）。

動作条件

次の表は、MTS4000 型システムの動作電源要件を示しています。MTS4000 型機器の動作電源要件の詳細につい

ては、『MTS4000 型 MPEG テスト・システム仕様および性能検査に関するテクニカル・リファレンス』を参照してくだ

さい。

要件 仕様

動作時温度 + 5 ℃ ～ + 40 ℃
動作高度 0 ～ 2,000 m（6,562 フィート）

動作時湿度 相対湿度 20% ～ 80%、結露なきこと

ソース電圧 100 ～ 240 VAC ± 10%（90 ～ 264 VAC RMS）
周波数レンジ 50/60 Hz
最大消費電力 220 W
ヒューズ ユーザによる交換不可。資格のあるサービス担当者へ

依頼すること。
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コントロールおよびコネクタ

このセクションでは MTS4000 型システム機器のコントロールとコネクタについて説明します。解析機能（有効な場

合）は、電源を供給し、機器のハード・ディスク上でトランスポート・ストリームを利用できるようにするだけで使用で
きます。モニタとリアルタイム解析機能も同様に電源を必要としますが、外部トランスポート・ストリームへの接続
も必要となります。

MTS4000 型システムは、購入時にご注文のソフトウェアおよびハードウェア・オプションで構成されます。

MTS4000 型システムのオプションは、当社が提供するアップグレード・キットを使用して追加できます。

注意： 過熱による装置の損傷を防ぐために、装置をベンチ上に置くときは、装置キャビネットの後部および両側面
に少なくとも 2 インチ（5.1 cm）のスペースを確保してください。

注意： その他の接続がすべて行われるまで、装置に電源を供給しないでください。

側面のコネクタ

次の図に MTS4000 型システムのコネクタを示します。
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図の参照番
号

説明 図の参照番
号

説明

1 メイン DVI ディスプレイ・ポート（メインフレ

ーム LCD へ）

セカンダリ DVI ディスプレイ・ポート
 2 3

6 PS/2 キーボード・コネクタおよびマウス・コ

ネクタ 1

2 ライン出力：メインフレームのスピーカに接
続
ライン入力：機能しません
マイク 1

7 オプションのインタフェース・カード用ベイ

3 USB ホスト・ポート 8 ネットワーク・インタフェース・カード（NIC）
用 RJ-45 LAN コネクタ

4 DVI、VGA ビデオ・コネクタ：機能しません 9 AC メイン電源スイッチ

5 COM 1 および COM 2 シリアル・ポート 10 AC メイン電源プラグ

設置場所に合った正しい電源コードを使
用してください。

フロント・パネル・コントロールおよびコネクタ

次の図と表に MTS4000 型のフロント・パネルのコントロールとコネクタを示します。
 

 

2 このポートにケーブルを接続しての EMC 性能テストは行われていません。
3 セカンダリ・ディスプレイ・ポートを使用して、MTS4000 型ディスプレイを表示したり拡張することができます。機器の起動時にディスプレイを接続して

おく必要があります。

 設置
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図の参照番
号

説明 図の参照番
号

説明

1 電源インジケータ。スタンバイ・モードのと
きに点滅します。

5 オン／スタンバイ・ボタン

2 ハード・ディスクの作動インジケータ 6 LCD コントロール

3 ディスプレイ ON/OFF ボタン 7 USB ホスト・ポート

4 再起動ボタン（凹型） 8 キーボード／マウス・コネクタ

オプション・カード用コネクタ

MTS4000 型システムには、各種トランスポート・ストリーム、ネットワーク、および周辺機器をサポートするオプショ

ンのカードを取り付けることができます。このセクションでは、各オプション・カードとそのコネクタについて説明しま
す。

各オプション・カードのコネクタと信号の入出力フォーマットの詳細については、『MTS4000 型 MPEG テスト・システ

ム仕様および性能検査のテクニカル・リファレンス』を参照してください。

注： 機器には最大で 4 つのオプション・カードを取り付けることができますが、 オプション DS2、VS、QB2、IPTV のい
ずれか 2 つのみ取り付けられます。

必ず USB ソフトウェア・キー（ドングル）をいずれかの USB ポートに取り付けてください。

注： MTS4000 型システムのアプリケーションとインストールされているオプション・カードにはソフトウェア・キーが必
要です。

アップグレードや修理のためにテスト・システムを当社サービス受付センターに返送する場合は、ソフトウェア・キ
ーを添付してください。

表 1 : オプション・カードとコネクタ

マルチポート ASI インタフェース（オプション

ASI 型）

コネクタ：75 Ω BNC

デュアル入力 DVB-S/S2 インタフェース（オプシ

ョン DS2 型）

DVB-S QPSK と DVB-S2 QPSK、8PSK、16APSK、
および 32APSK の変調方式をサポート

設置  
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シングル入力 DVB-S/S2 インタフェース（オプシ

ョン S2 型）

DVB-S QPSK と DVB-S2 QPSK、8PSK、16APSK、
および 32APSK の変調方式をサポート（オプシ

ョン ASI 型が必要）

注： オプション S2 型カードの販売は終了して
おり、上記のオプション DS2 型によって置き換
えられました。

8VSB インタフェース（オプション VS 型）

ATSC A/53B 準拠

（オプション ASI 型が必要）

QAM B インタフェース（オプション QB2 型）

64QAM、256QAM インタフェース

（オプション ASI 型が必要）

10GBase-SR デュアル・オプティカル・ポート

10GB/S NIC（オプション 10GS 型）

短距離用 SFP+ およびモジュール（850 nm）を

含む

IP ビデオ・インタフェース（オプション IPTV 型）

10／100／1000 Base-T RJ45 電気ポートの IPTV
ギガビット・イーサネット・インタフェース（オプ
ション ASI 型が必要）

 設置
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SFP モジュール（オプション SX 型、LX 型、ZX
型）
- 1000 Base-SX 短波長光ポート、IPTV イーサネ

ット・インタフェース用 LC コネクタ付き（マルチ

モード 850 nm）

- 1000 Base-LX 長波長光ポート、IPTV イーサネ

ット・インタフェース用 LC コネクタ付き（シング

ルモード 1310 nm）

- 1000 Base-ZX 光ポート、IPTV イーサネット・イ

ンタフェース用 LC コネクタ付き（シングルモー

ド 1550 nm）

注意：

ケーブルを接続していないときは、SFP モジュ
ールに光ポート・プラグを必ず取り付けてくだ
さい。

有害なレーザ光線にさらされるのを避けるた
め、米国の連邦規制 CDRH 21 CFR 1040 およ
び IEC/EN 60825/A2:2001 で規定されているよう
に、Class 1 レーザのみを使用してください。

MTS4SAV3 型スタンドアロン・システムの設置

MTS4SAV3 型スタンドアロン・システムを使用すると、MTS4000 システム・アプリケーションが PC 上で使用できま

す。

MTS4SAV3 型には USB ドングルとオプション・キーが付属します。USB ドングルにはオプション・キーが格納されて

おり、PC に取り付けると MTS4000 型システムの各種ソフトウェア・オプションが利用できるようになります。USB ド
ングルに格納されているオプション・キーは、購入したソフトウェア・オプションによって異なります。MTS4SAV3 型を

開くには、USB ドングルとオプション・キーの両方が必要です。

オプション ESB 型または ESE 型（MTS4EAV7 HEVC / AVC Video and Compressed Audio Analyzer）またはオプション CA
型（MTS4EAV7 クローズド・キャプション・アナライザ・ソフトウェア）を注文した場合は、『MTS4EAV7 User Manual』に
記載されているインストール手順を使用します。

システム要件

MTS4SAV3 型スタンドアロン・システムのインストールには、次の最小 PC 構成が推奨されます。

■ Microsoft Windows 7 または Windows 8.1、64 ビット版オペレーティング・システム

■ プロセッサ速度 >2.5 GHz
■ 4 GB 以上の RAM
■ 1024x768 以上の画面解像度

■ 250 GB 以上のハード・ディスク容量
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オプション ESB 型および ESE 型のシステム要件

オプション ESB 型または ESE 型（MTS4EAV7 HEVC / AVC Video and Compressed Audio Analyzer）またはオプション CA
型（MTS4EAV7 クローズド・キャプション・アナライザ・ソフトウェア）を注文した場合は、次の最小 PC 構成が推奨さ

れます。詳細については、『MTS4EAV7 User Manual』を参照してください。

■ Microsoft Windows 7 または Windows 8.1、64 ビット版オペレーティング・システム

■ プロセッサ速度 >2.5 GHz
■ 4 GB 以上の RAM
■ 250 GB 以上のハード・ディスク容量

設置手順

1. 設置が完了したら、MTS4000 型の

USB ソフトウェア・キー（ドングル）を

PC の USB ポートから抜いてくださ

い。

注意：

インストールの問題を防ぐために、ソ
フトウェアのインストールを開始する
前に PC からソフトウェア・キー（ドン
グル）を取り外すことをお勧めしま
す。

2. MTS4000 アプリケーション・ソフトウェ

アのメディアを PC の DVD ドライブに

入れます。

インストール・プログラムが開始さ
れ、Welcome という画面が表示され

ます。 

Windows とセキュリティの設定によっ

ては、MTS4000 のインストールが自

動的に開始しないことがあります。 

必要な場合は Windows エクスプロー

ラを使用して、MTS4000 アプリケーシ

ョン・ソフトウェア・メディア上の
MTS4000_setup.exe を探して実行して

ください。右クリックして、Run as
administrator を選択します。 

3. インストールの Welcome 画面で、

Next を選択します。

 設置
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4. エンドユーザ・ライセンス契約書
（EULA）を読みます。契約書に同意

し、Next を選択します。

5. Choose Setup Type 画面で、Install on
Standalone PC を選択して、PC に
MTS4SAV3 ソフトウェアをインストー

ルします。

6. Next を選択します。
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7. Ready to Install 画面で、Install を選択

します。

注： インストールの途中、メッセー
ジ・ボックスが何回か表示されます
が、通常、ユーザの操作は必要あり
ません。

インストール時に MTS4000 ソフトウェ
アの旧バージョンが検出されると、ソ
フトウェアは自動的にアンインストー
ルされます。

 

8. そのままインストールを進めます。

9. DESkey インストーラが表示された

ら、Next を選択して、DESkey のイン

ストール・プロセスに進みます。
Windows のセキュリティ設定によっ

て、デバイス・ソフトウェアをインスト
ールする際にセキュリティ・メッセー
ジが表示されることがあります。
Install を選択します。

正しいバージョンの DESkey が既に

インストールされていることが検出さ
れた場合、DESkey のインストールは

スキップされます。 

 設置
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10. WinPcap インストーラが表示された

ら、Next を選択します。

WinPcap のインストールを続けま

す。 

正しいバージョンの WinPcap が既に

インストールされていることが検出さ
れた場合、WinPcap のインストール

はスキップされます。 

11. インストールの完了画面が表示され
たら、Finish を選択します。

オプション・キーを入力する前や、ア
プリケーションを使用する前には、リ
ブートが必要です。 
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12. PC が再起動したら、MTS4000 型の

USB ソフトウェア・キー（ドングル）を

PC の USB ポートに取り付けます。

13. ソフトウェア・キー（ドングル）が検出
されたら、Start > Programs >
Tektronix MTS4000 > OptionKey
Wizard を選択して、MTS4000 Option
Key Wizard を開きます。

14. Tektronix Option Update ダイアログ･ボ

ックスで、インストレーション・マニュ
アルと共に提供されたオプション･キ
ー文字列を Key String フィールドに入

力します。

15. Apply をクリックします。

16. ライセンス・オプションのリストを調べ
て確認します。 

注： 各機能へのアクセスは、ソフトウ
ェア・キーで利用可能なライセンスに
よって制御されます。アプリケーショ
ンおよび機能はインストールできま
すが、適切なライセンスが取得され
るまで使用できません。これらのこと
は、製品または追加ライセンスを購
入するときにお知らせしています。

MTS4EAV7 型および MTS4CC 型のラ
イセンスは USB ドングルに格納され
ています。VQS および PQA ソフトウ
ェアには個別のライセンスが必要で
す。

17. Option Key Wizard を閉じます。

18. これでライセンスされた MTS4SAV3
スタンドアロン・アプリケーションが、
Windows の Start メニューで使用でき

るようになりました（アプリケーション
の起動(26 ページ)を参照）。
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電源投入方法

電源の供給

MTS4000 型システムは、単相電源（そのうちの 1 本はアース（近傍）電位の中性線）で動作するように設計されて

います。相間や多相方式など、2 本の導体がグランドに対して相電圧を持つ電源はお勧めできません。操作の安

全のために、電源コードの接地用導体を通じた保安用グランド接続が必須です。

MTS4000 型システムを設置して信号および周辺装置の接続が完了したら、電源コードをメイン電源に差し込みま

す。

電源の投入

テスト・システムの電源は次のようにしてオンにします。

1. キーボード・ロックを上にスライドさ
せます。

2. キーボードを開きます。

3. フロント・パネルのオン／スタンバ
イ・スイッチを押して、機器の電源を
入れます。

注： リア・パネルのメイン・スイッチが
入っていることを確認してください。

 

電源投入時のセルフテストが完了す
るまで待ちます。 

デフォルトのユーザ名は "MTS"、パ
スワードは "mts" です。

注： ユーザ・アカウントとパスワード
の設定については、Windows のヘル
プ・ドキュメントを参照してください。
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キーボードの取り外し

1. キーボード・ピンを内側にスライドさ
せます。

2. MTS4000 型のケースからキーボード

を外側にスライドさせます。

電源切断方法

フロント・パネルのオン／スタンバイ・ボタンを押して離します。以上の操作でシステムは自動的にシャット・ダウン
し、電源が切れます。

または、Windows 7 のシャットダウンを使用して機器の電源をオフにします（Start > Shut down... を選択）。システム

（アプリケーションを含む）が自動的にシャット・ダウンします。

機器が応答しなくなった場合は、オン／スタンバイ・ボタンを 5 秒間押し続けてください。これにより、Windows の電

源切断シーケンスを省いて、機器の電源が強制的に切られます。
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VLC Media Player のインストール

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）でビデオを見られるようにするには、VideoLAN の
Web サイトから最新バージョンの VLC Media Player をダウンロードしてインストールする必要があります。

1. インターネットにアクセスできる PC
または MTS4000 型機器を使用して、

VideoLan の Web サイト

（www.videolan.org）に移動します。

2. Windows 自己解凍形式の VLC Media
Player のインストーラを探して PC の
ハード・ディスクにダウンロードしま
す。32 ビット版を使用することをお勧

めします。

3. 機器上にダウンロードされた VLC
Media Player ファイルを探して実行し

ます。

4. 使用する言語を選択します。
Welcome / Setup 画面が表示されま

す。

5. セットアップ手順に従って、VLC Media
Player をインストールします。

これで、必要な作業が終了しました。VLC Media Player は必要に応じて TSCA アプリケーションから使用されます。

ネットワーク構成

MTS4000 型システムは、コンピュータ・ネットワークに接続することができます。正しいネットワーク設定の詳細に

ついては、ネットワーク管理者に問い合わせてください。インストールおよび操作手順については、ご使用のネット
ワーク・ハードウェアおよびソフトウェアに付属のドキュメントを参照してください。

ネットワークのトラブルシューティング

ネットワークは各種規格に基づいていますが、各ネットワーク（LAN または WAN）には固有の特性が多数存在する

ため、特定のネットワークに関する十分な知識がないとトラブルシューティングは困難になります。そのため、ネッ
トワークの詳細なトラブルシューティングは、そのネットワークの特性に精通している専門家が実行すべきです。

このセクションでは、ネットワーク・エラーの一般的ないくつかの原因を解消できる基本的な手順を紹介します。こ
れらの手順を使用しても問題を解決できない場合は、ネットワーク管理者にお問い合わせください。
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基本的な要件

ホスト・マシンのトラブルシューティングを行う前に、次の要件が満たされるようにしてください。

■ 接続するネットワークに合わせてシステムを設定します。詳細については、ネットワーク管理者にお問い合わ
せください。MTS4000 型の NIC は DHCP でアドレスを自動割り当てするように設定されています。

■ テスト・システムの購入後にインストールしたアプリケーションの中に、テスト・システム・コンポーネントに割り
当てられたポートを使用しているものがないかを確認します。

IP パラメータ

このセクションでは、各 IP パラメータ（IP アドレス、サブネット・マスク、およびデフォルト・ゲートウェイ）がネットワー

ク接続におよぼす悪影響を図で説明します。

IP アドレスの誤り： テスト・システムの IP アドレスが正しくない（固有でない）場合は、ネットワーク上で通信できな

い可能性があります。次の図では、TVTest_1 が Rennes と同じ IP アドレスを使用しています。Rennes が最初に起

動されると、TVTest_1 は IP アドレスの競合を認識し、TCP/IP をロードしません。この結果、ネットワーク経由でシス

テムに到達できません。

IP アドレスが正しくなく、サブネット上に存在しない場合でも、デバイス（システムまたは監視ステーション）からの

通信は可能な場合がありますが、デバイスへの通信は不可能になる場合があります。
 

 

 設置

MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル 15



サブネット・マスクの誤り： サブネットやサブネットを含むネットワークは複雑であり、IP アドレス指定についての十

分な知識を必要とします。発生しているネットワークの問題にサブネットが関係していると思われる場合は、ネット
ワーク管理者にお問い合わせください。次の図は、単純な（比較的よく見られる）サブネット・マスクの問題を示し
ています。

図の TVTest_1 のサブネット・マスクは、ネットワーク・アドレスが IP アドレスの最初の 2 バイトに含まれていることを

示しています。ドット区切りの 10 進表記では、ネットワーク・アドレスは 128.181 です。この情報により、デバイスは

デフォルト・ゲートウェイ経由でルーティングされなくても、同じネットワーク・アドレスを持つ他のデバイスと通信で
きます。
 

 

TVTest_1 は Carnac とは通信できません。これは、TVTest_1 のサブネット・マスクによると、Carnac と TVTest_1 が論

理的に同じネットワーク上に存在するためです。この結果、TVTest_1 から Carnac に送信されたメッセージはルーテ

ィングされなくなります。この 2 つのデバイスが接続を共有していないため、TVTest_1 は Carnac のネットワーク・カ

ードの正しいアドレスを見つけることができず、Carnac には到達できません。

TVTest_1 は、TVTest_2 および Rennes とは通信できます。それは、これら 3 つのデバイスが接続を共有しているた

め、TVTest_1 からのメッセージをルーティングする必要がないためです。したがって、正しくないサブネット・マスク

が設定されているにもかかわらず、TVTest_1 は TVTest_2 および Rennes の正しいアドレスを見つけることができま

す。

設置  

16 MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル



デフォルト・ゲートウェイの IP アドレスの誤り： TCP/IP Properties ダイアログ・ボックスで指定したデフォルト・ゲートウ

ェイは、ネットワーク上の各サブネットワークを "認識している" デバイスです。メッセージ（たとえば、あるシステム

から他のサブネット上のデバイスへのトラップ）を送信する場合、デフォルト・ゲートウェイはそのメッセージを適切
なサブネットにルーティングできます。TCP/IP Properties ダイアログ・ボックスで指定した IP アドレスが間違っている

と、他のサブネット上のデバイスへのメッセージは（デフォルト・ゲートウェイまで届かないため）宛先には到達しま
せん。
 

 

一般的なトラブルシューティング手順

以降のセクションで実行する手順の多くは、一般的な作業です。
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ホスト・マシンへの Ping： すべての TCP/IP インストールに提供されるユーティリティの 1 つに ping.exe があります。

このユーティリティでは、ホスト・マシンに通信パケットを送信し、そのマシンからの応答を記録できます。この操作
により、パケットが宛先に到達したかどうかが判別されます。

注： Windows ファイヤウォールを無効にしない限り、MTS4000 型で ping ユーティリティは動作しません。

Ping を実行するには、次の手順を使用します。

1. 次のキーを同時に押します。

■ Windows キー（ ）+ R
■ ping Machine_Name
■ ping IP_address

 

これにより、Run ダイアログが表示さ

れます。 

2. Run のテキスト・ボックスに、次のい

ずれかを入力します。

この例では、Machine_Name と
IP_address がそれぞれ、ping 先のネ

ットワーク・デバイスのホスト・マシン
名と IP アドレスを表しています。 

3. OK をクリックします。

DOS ウィンドウに、マシンが ping に
応答しているかどうかが示されま
す。 

Ping は短時間だけ実行され、プロセ

スが完了すると DOS ウィンドウは閉

じられます。 
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TCP/IP パケットのルートのトレース： パケットが、宛先マシンまでの経路のどこまで到達したかや、その途中でパ

ケットがどのデバイスを通過したかが分かると便利な場合があります。この機能を提供するユーティリティが
tracert.exe です。tracert は、ネットワーク内の混雑したポイントを示すこともできます。tracert を実行するには、次の

手順を使用します。

1. 次のキーを同時に押します。

■ Windows キー（ ）+ R
■ tracert Machine_Name
■ tracert IP_address

 

これにより、Run ダイアログが表示さ

れます。 

2. Run のテキスト・ボックスに、次のい

ずれかを入力します。

この例では、Machine_Name と
IP_address がそれぞれ、到達先のネ

ットワーク・デバイスのホスト・マシン
名と IP アドレスを表しています。 

3. OK をクリックします。

DOS ウィンドウは、パケットの進行状

況を示しています。右端の列は、
tracert パケットを正常に通したネット

ワーク上のノードの IP アドレスを示

しています。この情報は、宛先デバ
イスまでの経路上にある最後の正
常なノードを示しています。 
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ネットワーク上のデバイスの IP アドレスの調査： ネットワーク上のコンピュータの IP アドレス（または、IP アドレス

が分かっている場合はネットワーク名）の調査が必要となる場合があります。この情報が得られると、Hosts ファイ

ルで使用している IP アドレスやネットワーク名が正しいかどうかを確認できます。ユーティリティ nslookup.exe でこ

の情報が得られます。

1. 次のキーを同時に押します。

■ Windows キー（ ）+ R
■ nslookup Machine_Name
■ nslookup IP_address

 

これにより、Run ダイアログが表示さ

れます。 

2. Run のテキスト・ボックスに、次のい

ずれかを入力します。

Machine_Name または IP_Address は、

それぞれ調べたいデバイスのネット
ワーク名または IP アドレスです。 

3. OK をクリックします。

目的のデバイスのネットワーク名と
IP アドレスが表示されます。ネットワ

ークで DNS を使用している場合は、

DNS サーバの IP アドレスとネットワ

ーク名も表示されます。 

注： Run コマンドで nslookup を使用す
ると、結果が表示される時間が短す
ぎることがあります。クライアント PC
上でコマンド・プロンプトのウィンドウ
を開きます（Start > All Programs >
Accessories > Command Prompt）。
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NIC 帯域幅制限

MTS4000 型プラットフォームは、IP 信号の解析用として 2 つの CAT5 ネットワーク・インタフェース・カード（NIC）を提

供します（側面のコネクタ(2 ページ)を参照）。NIC の名前と帯域幅は少しずつ異なります。以下のように、Control
Panel > Network and Internet > Network Connections を使用して、使用可能なネットワーク接続を表示できます。
 

 

上段の NIC。 上段の NIC のデバイス名は Intel 82583V です。通常、LAN および MS RDP のリモート・コントロールに

使用します。この NIC の I/O 帯域幅制限は次のとおりです。

■ MPEG Player 出力：最大 80 Mbps
■ TSCA IP 入力：最大 400 Mbps

下段の NIC。 下段の NIC のデバイス名は Intel 82578DM です。I/O 帯域幅制限は次のとおりです。

■ MPEG Player 出力：最大 250 Mbps
■ TSCA IP 入力：最大 600 Mbps

オプションの 10GS インタフェース。 オプションの 10GS（10 Gbps）インタフェース・カードのデバイス名は Intel X520 で
す。I/O 帯域幅制限は次のとおりです。

■ MPEG Player 出力：最大 300 Mbps
■ TSCA IP 入力：最大 600 Mbps

注： オプションの IPTV インタフェースには、帯域幅制限はありません。

ネットワーク情報の入手先

ネットワークのトラブルシューティングに関してさらに多くの情報が必要な場合、次のリソースが役立つ可能性が
あります。

■ Cisco Systems, Inc. – http://www.cisco.com/

このサイトは特に、Cisco 製デバイスを使用しているネットワークに役立ちます。

■ Dulaney, E、Lawrence, S、Scrimger, R、Tilke, A、White, J、Williams, R、Wolford, K 著、『MCSE Training Guide:TCP/IP』。
Indianapolis, IN. New Riders, 1998

これは、MCSE（マイクロソフト認定システム・エンジニア）資格のためのトレーニング・ガイドで、TCP/IP とネット

ワークのトラブルシューティングを扱っています。

■ Taylor, E 著、『Network Troubleshooting Handbook』。New York, NY.McGraw-Hill, 1999
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注： これらのリソースから多くの情報が得られますが、その大部分はそのまま提供されており、その適合性につい
ては、書面または黙示を問わず保証されていません。ネットワークに関するトラブルシューティング情報の最善の
入手先は、担当のネットワーク管理者です。
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操作

製品の説明

MTS4000 型 MPEG テスト・システムには、リアルタイム解析および事後解析（デファード）に必要なすべてのツール

が用意されています。これらのツールには、TS（トランスポート・ストリーム）コンプライアンス、バッファ、PES、
MPEG2、および MPEG4 のビデオおよびオーディオ・エレメンタリ・ストリーム・アナライザがあります。ストリーム・コ

ンテンツやテストおよびエラー・ストレス・ストリームを作成するためのエディタおよびマルチプレクサもあります。

MTS4000 解析ツールセットの各アプリケーションは、トランスポート・ストリームの特定の側面または層を対象とし

ています。以下の図は、この原理を簡略化された形で示しています。
 

 

「手順」のセクションでは、アプリケーションの開始方法、テストストリームの解析方法、結果の表示について説明
しています。結果の解釈方法については説明しません。

批准された DTV 規格や更新される DTV 規格を幅広くサポートするカスタマイズ可能な組込みスクリプトを通して、

規格への適合性が保証されます。新しい規格や独自仕様のテーブルは、当社が提供する更新を読み込むか、ま
たは独自のカスタム・スクリプトを作成することにより簡単に実装できます。
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ソフトウェア・アプリケーション

このセクションでは、MTS4000 型 MPEG テスト・システムを構成するソフトウェア・アプリケーションの概要を簡単に

説明します。一部のオプションが有効になっていない場合があることに注意してください。すべてのアプリケーショ
ンに関する詳細な説明は、『MTS4000 システム MPEG テスト・システム・アプリケーション・ユーザ・マニュアル』を参

照してください。

Application アイコン
 1

アナライザ

トランスポート・ストリーム・コンプライアンス・ア
ナライザ（TSCA）：リアルタイムおよび事後のト

ランスポート・ストリーム解析。MPEG-2、DVB、
および ATSC から適合テスト項目を選択可能で

す。トランスポートの構造、ヘッダの内容、パケ
ットの内容の 16 進表示、PCR タイミング／トラ

ンスポート・レート・グラフ、およびエラー・メッセ
ージ・ログを表示します。

MTS4000 型テスト・システムに取り付ける最初

の RF/IP カードは ASI カードの上に取り付けま

す。この RF/IP カードには、スタート・メニューと

デスクトップの Real Time Analyzers フォルあにあ

る TS Compliance Analyzer アイコンを使用してア

クセスできます。

MTS4000 型テスト・システムに取り付ける 2 番
目の RF/IP カードは ASI カードの下に取り付け

ます。この RF/IP カードには、デスクトップの

Real Time Analyzers フォルダにある TS
Compliance Analyzer P1 アイコンを使用してアク

セスします（スタート・メニューに TSCA P1 のア

イコンはありません）。

パケット化エレメンタリ・ストリーム（PES）アナライザ：選択可能なテスト・オプションを持つ PES
解析。PES プログラム構造、ヘッダの内容、パケットの内容、PTS/DTS タイミング・グラフ、および

解析レポートを表示します。

トランスポート・ストリーム・システム・ターゲット・デコーダ（T-STD）バッファ・アナライザ：

MPEG-2 T-STD バッファ・モデルにおける、プログラム・ストリームの振る舞いをモデリングし、そ

れに対する適合性を解析します。トレース機能も搭載されています。

エレメンタリ・ストリーム・アナライザ：ビデオ映像およびオーディオ・レベルでのエレメンタリ・スト
リーム解析。これには、ベクトル・グラフとマクロブロックのピクチャ品質が含まれます。

カルーセル・アナライザ：データ項目の構造、ビット・レート、反復率、構文、およびセマンティク
スを表示するデータ解析。

ゼネレータ

1 インストール済みでライセンスがある場合。
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Application アイコン
 1

カルーセル・ゼネレータ：さまざまなデータ放送プロトコルを含む MPEG-2 および DVB トランスポ

ート・ストリームをオフラインで詳細に生成します。

ISDB-T Remux：既存の 188 または 204 バイトのトランスポート・ストリーム・ファイルを ISDB-T/Tb
（ARIB STD-B31）準拠のファイル（パケットあたり 204 バイト）に再多重化します。ファイルの拡張

子は .RMX になり、TMCC および IIP セクションが含まれます。

マルチプレクサ：テーブル情報とパケット化エレメンタリ・ストリームを多重化し、新しいトランス
ポート・ストリームを合成します。新しいトランスポート・ストリームに対して非適合性およびテス
ト・ケースを指定できるように、きめ細かい制御が可能です。

Ｔ S Editor：パケット・コンテンツの 16 進表示とヘッダのセマンティクス解釈を使用して、トランスポ

ート・ストリーム・パケットの表示および編集を行います。PID の再マッピング、PCR 値の再計

算、PCR 誤差の導入などの機能を提供します。

プレーヤ

MPEG Player： MPEG-2 トランスポート・ストリームを再生します。

ユーティリティ

Make Seamless Wizard：ストリーム・プレーヤの連続ループ･モードで使用する MPEG-2 トランスポ

ート・ストリームのファイルの作成手順を案内します。

Stream Cutter： MPEG-2 トランスポート・ストリーム・ファイルの一部を切り取って新しいファイルに

抽出します。

1 インストール済みでライセンスがある場合。

 操作
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Application アイコン
 1

スクリプト･パッド：ユーザがシステム情報（SI）スクリプトの作成と変更を行えるようにします。

TTS ユーティリティ：タイム・スタンプ付きのトランスポート・ストリームを標準的なトランスポート・

ストリーム形式に変換します。

アプリケーションの起動

すべてのアプリケーションは、Start > All Programs > Tektronix MTS4000 メニューか、またはデスクトップ・フォルダ

（Real Time Analyzers、Deferred Time Analyzers、Generators、Player、または Utilities）のショートカットから起動します。

注： 2 番目の RF/IP カード（下のスロット）にアクセスするには、デスクトップの Real Time Analyzers フォルダの中にあ
る TS Compliance Analyzer P1 アイコンを使用する必要があります。

MTS4000 システム・アプリケーションの各ユーザ・マニュアルに、アプリケーションの説明が記載されています。以

下の表は、Start メニューのアプリケーション階層を示しています。

Start メニューの階層構造

Tektronix MTS4000 > OptionKey Wizard
Analyzers > Buffer Analyzer

Carousel Analyzer
ES Analyzer
PES Analyzer
TS Compliance Analyzer

Generators > Carousel Generator
ISDB-T Remux
Multiplexer
TS Editor

Player > MPEG Player
Utilities > Make Seamless Wizard

ScriptPad
Stream Cutter
TTS Utility

1 インストール済みでライセンスがある場合。
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注： スタート・メニューに表示されるアプリケーションのうち、開くことができるオプションは購入済みのものだけで
す。

デュプレックス操作

MTS4000 型機器はデュプレックス・モードで操作できます（ASI または SPI のみ）。たとえば、プレーヤがストリーム

を再生しているときに、トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）は別のストリームを解析で

きます。また、出力を入力へループバックすると、プレーヤの出力を TCSA でモニタできます。

ループバックのセットアップ

ループバックを実行すると、を行うことができます。

■ MPEG Player を使用してストリームを再生する

■ 機器の出力を入力にループバックする（たとえば、ASI カードで ASI-4 を ASI-3 にループします。10G カードで

LC マルチモード・ジャンパ・ケーブルを使用して出力を入力にループします）

■ TSCA を使用して入力ストリームをモニタ／解析する

開始する前に：

■ 再生するストリームを決定する（この例では、sym1.mpg テスト・ストリームを使用）

■ 入出力インタフェース（ASI）を選択し、必要な接続（コネクタ間のループ）を行う

次の例では、ASI インタフェースを使用してストリームをループ・バックし、ストリームをプレーヤ内でループします

（連続再生のために）。

MTS4000 型のセットアップ。

1. ASI-4 コネクタと ASI-3 コネクタをケーブルで接続します。

MPEG player のセットアップ：

1. MPEG Player を開きます：Start > All Programs > Tektronix MTS4000 > Player > MPEG Player の順に選択します。

2. ストリームを開きます：File>Open...> Sym1.mpg の順に選択します。

注： Sym1.mpg ファイルは、MTS4000 アプリケーションの理解を支援する目的で提供されています。ファイル
は、MTS4000 型のハード・ディスク（c:\TestStreams）、Tclips MPEG テスト・ストリーム DVD、およびマニュアル・ブ
ラウザ CD など、いくつかの場所にあります。

3. Play メニューで次の設定を行います。

■ Interface:ASI
■ Packet size:188
■ Update:On
■ Loop:On
■ Other:Standard:DVB

4. ASI メニューで次の設定を行います。

■ ASI Out:ASI-4

 操作
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TSCA のセットアップ：

1. TSCA を開きます：Start > All Programs > Tektronix MTS4000 > Analyzers > TS Compliance Analyzer の順に選択し

ます。

2. 最初に表示される Open Transport Stream... ダイアログ・ボックスの Stream Interpretation で、Change... を選択

し、拡張機能のない DVB ベース規格を選択します。Stream Interpretation ダイアログ・ボックスを閉じます。

3. Real-time Analysis を選択し、Interfaces ドロップダウン・リストから ASI-3 を選択します。

4. OK を選択します。

再生と解析の開始：

1. MPEG Player のウィンドウに戻り、次の手順でストリームを再生します。Play>Start/Stop またはツール・バー・ボ

タンを使用します。

2. プレーヤ・ウィンドウでは、ステータス・バーが表示され、再生が開始されています。

3. TSCA ウィンドウに戻ると、解析が開始されています。

MPEG Player は sym1.mpg トランスポート・ストリームを再生中であり、TSCA は、機器のコネクタ・パネルの ASI 入力

および出力を介してストリームをモニタし解析しています。

MPEG Player および TSCA の詳細については、『MTS4000 アナライザ・アプリケーション・ユーザ・マニュアル』を参

照してください。

インタフェース・カードのステータス LED
オプションの ASI および DVB-S2（オプション DS2）インタフェース・カードのリア・パネルには、入出力信号のステー

タスを示す LED があります。 次の表に、それぞれのステータスの状態を示します。

表 2 : ASI および DVB-S2 の出力

LED パターン 説明

オレンジ色に短く点滅 出力なし

オレンジ色に長く点滅 ヌル・パケット・スタッフのみ（実際のデータはなし）

オレンジ色に点灯 ライブ出力を生成中

表 3 : ASI および DVB-S2 の入力

LED パターン 説明

緑色に短く点滅 キャリア／信号が未検出

緑色に長く点滅 キャリアを検出したがデータはなし

緑色に点灯 有効データを検出

赤色に点灯 不正な信号が接続された

赤色の短い点滅（5 回） コード違反

操作  
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手順

マルチプレクサの使用

次のアプリケーション例では、マルチプレクサを使用して新規トランスポート・ストリームを作成し、エレメンタリ・ス
トリームをトランスポート・ストリームに追加します。

この手順で作成される新規トランスポート・ストリーム（名前 TestMux.mpg）は、このマニュアル内で追加のいくつか

の手順で使用されます。

マルチプレクサを使用した新規ストリームの作成

使用例のこのセクションでは、Multiplexer アプリケーションを使用して新しいトランスポート・ストリームを作成しま

す。意図的にエラーを 1 つ加えて、使用例の後のセクションでその影響を確認できるようにします。

1. Multiplexer アプリケーションを開くに

は、Start > Programs > Tektronix
MTS4000 > Generators > Multiplexer
の順に選択します。

2. View > Interpretation を選択します。

3. Stream Interpretation ダイアログ・ボッ

クスで、Base Standard として DVB が
選択され、Region が None になってい

ることを確認します。

4. OK を選択して、Stream Interpretation
ダイアログ・ボックスを閉じます。
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5. File > New を選択します。

6. Navigator ウィンドウで、トランスポー

ト・ストリームのノードをハイライトし、
コンテキスト・メニューから Properties
を選択します。

7. Stream Properties ダイアログ・ボックス

で、ビット・レートとして 24.128 MBps
を入力し、固定継続期間として 2 分
（120 秒）を入力します。OK を選択し

ます。

この 2 つの値がステータス・バーに

表示されていることに注意してくださ
い。 

8. Navigator ウィンドウで、トランスポー

ト・ストリームのノードをハイライトし、
コンテキスト・メニューから Add を選

択します。
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9. Transport Stream Settings ダイアログ･

ボックスで、トランスポート・ストリー
ムの ID として「1」を入力します。

10. PAT（Program Allocation Table）フォル

ダ・アイコンのボタンを選択して、PAT
Timing ダイアログ・ボックスを開きま

す。

Version Timing タブ・ウィンドウに表示され

ている PAT タイミングの Start Time（0 秒）

と Stop Time（120 秒）は、PAT がこのストリ

ーム期間で送信されることを意味してい
ます。 

11. OK を選択して、PAT Timing ダイアロ

グ・ボックスを閉じます。

12. Transport Stream Settings ダイアログ・

ボックスで、Next を選択します。

13. Optional Tables for the Stream ダイアロ

グ・ボックスで、TDT（Time and Date
Table）チェック・ボックスを選択し、

TDT フォルダ・アイコンのボタンを選

択します。

 手順
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TDT Timing ダイアログ・ボックスで、Start
Time がゼロに設定され、Stop Time が前

に設定した継続期間と同じ値に設定され
ていることを確認します。 

この継続期間は、若干調整されている場
合があることに注意してください。この例
では、120 秒と設定した継続期間が

119.999976127 と表示されています。 

14. Cycle Time に「1000」ms と入力しま

す。

15. OK を選択して、TDT Timing ダイアロ

グ・ボックスを閉じます。

16. Optional Tables for the Stream ダイアロ

グ・ボックスで、NIT（Network
Information Table）チェック・ボックスを

選択し、NIT の Settings ボタンを選択

します。

17. Set up the NIT ダイアログ･ボックス

で、Network Id に「1234」、また Network
Name に「Tek_test」と入力します。

18. Original Network Id を 2 に設定し、

Delivery System ドロップダウン・リスト

から Terrestrial を選択します。

19. Delivery System の Settings ボタンを選

択します。
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20. Terrestrial Settings ダイアログ･ボック

スで、Centre Frequency フィールドに

「0x123456」と入力します。

21. Constellation ドロップダウン・リストか

ら 2 (64-QAM) を選択します。

22. Hierarchy Info ドロップダウン・リストか

ら 4 (non-hierarchical, in-depth
interleaver) を選択します。

23. Transmission Mode ドロップダウン・リ

ストから 1 (8k mode) を選択します。

24. OK を選択して、Terrestrial Settings ダ
イアログ・ボックスを閉じます。

25. OK を選択して、Set up the NIT ダイア

ログ・ボックスを閉じます。

26. Optional Tables for the Stream ダイアロ

グ・ボックスで、Next を選択すると、

Transport Wizard Complete ダイアログ・

ボックスが表示されます。

以上でトランスポート・ストリームの
セットアップは完了です。ここで、何
らかのコンテンツをビデオ・エレメン
タリ・ストリームおよびオーディオ・エ
レメンタリ・ストリームの形式で追加
する必要があります。 

Transport Wizard Complete 画面は閉じ

ないでください。 

 手順

MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル 33



エレメンタリ・ストリームのアクイジション： この例では、作成したトランスポート・ストリームに、ビデオ・エレメンタ

リ・ストリームとオーディオ・エレメンタリ・ストリームを追加する必要があります。MTS4000 インストールに付属して

いるサンプルのトランスポート・ストリームのいずれかから適切なストリームを解凍できます。この例で使用するス
トリームは Sym1.mpg です。このファイルは、MTS4000 型のハード・ディスク、Tclips MPEG テスト・ストリーム DVD、お
よびマニュアル CD にあります。

1. マルチプレクサの 2 つ目のインスタ

ンスを開きます。Start > Programs >
Tektronix MTS4000 > Generators >
Multiplexer の順に選択します。

2. File > Open を選択します。

3. Set MPEG File to Edit ダイアログ･ボッ

クスで、sym1.mpg を検索して開きま

す。

4. プログラム 1 のノードと、その下のエ

レメンタリ・ストリーム・ノードを展開し
ます。

5. PID 110 ノードをハイライトします。こ

の PID は、MPEG-2 ビデオ・エレメンタ

リ・ストリームを伝送します。

6. コンテキスト・メニューから Export
Elementary Stream を選択します。

7. Save As ダイアログ･ボックスで、ファ

イル名（「Sym1pid110.es」）を入力し、

適切な場所にファイルを保存しま
す。

8. PID120 にも、同様の手順を繰り返し

ます。ファイルの名前は
Sym1pid120.es にします。

9. File > Exit を選択して、マルチプレク

サのこのインスタンスを閉じます。

以上で、ビデオ・エレメンタリ・ストリ
ームとオーディオ・エレメンタリ・スト
リームの解凍は完了です。続けて多
重化タスクを実行できます。 
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エレメンタリ・ストリームの追加： これで、元のマルチプレクサのインスタンスに戻り、先程作成したエレメンタリ・ス

トリームを追加できます。

1. Add a Program Wizard がオンになっ

ていることを確認し、Next を選択しま

す。

2. Add a Program ダイアログ・ボックス

で、プログラム番号として 1 を入力し

ます。

3. PMT フォルダのアイコンを選択しま

す。

4. PMT Timing ダイアログ・ボックスで、

Subtable Timing タブを選択します。

サブテーブル・タイミング・サイクル
時間とは、ストリーム内でテーブル
が繰り返される期間のことです。DVB
規格における PMT の最大サイクル

時間は 500 ms です。 

5. このストリーム例では、サイクル・タ
イムを「525」ms に設定します。

6. OK を選択して、PMT Timing ダイアロ

グ・ボックスを閉じます。

7. Add A Program ダイアログ・ボックス

で、Next を選択します。

 手順
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8. Add Service Description ダイアログ・ボ

ックスで、Add Service Description チ
ェック・ボックスを選択します。

9. Service Provider Name に（「Tek
Broadcasting」 など）を入力します。

10. Service Name に（「Tek1」 など）を入

力します。

11. Service Type に（「1 (0x1) (digital
television service) 」など）を入力しま

す。

12. Next を選択します。

13. Add the Program Content ダイアログ・

ボックスで、Add を選択し、ビデオ・

エレメンタリ・ストリームを追加しま
す。

14. Add Program Stream ダイアログ･ボッ

クスで、Stream Type ドロップダウン・

リストから 2 (0x02) (MPEG-2 Video) を
選択します。

15. Source タブが選択されていることを

確認します。

16. File name を入力するか、Browse を
使用して以前セットアップしたビデ
オ・エレメンタリ・ストリーム
（Sym1pid110.es）を探します。

17. File type ドロップダウン・リストで

MPEG-2 video を選択します。ファイル

のビット・レートは自動的に入力され
ます。
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Timing タブを選択します。エレメンタリ・ス

トリームは、以前に設定したストリーム
長、つまり 120 秒間実行されることに注

意してください。 

18. PCR タブを選択します。Carry PCR チ
ェック・ボックスが選択されているこ
とを確認します。

19. OK を選択して、Add Program Stream
ダイアログ・ボックスを閉じます。

20. Add the Program Content ダイアログ・

ボックスで、Add を再度選択し、オー

ディオ・エレメンタリ・ストリームを追
加します。

21. Stream Type ドロップダウン・リストか

ら 3 (0x03) (MPEG-1 Audio) を選択し

ます。

22. Add Program Stream ダイアログ･ボッ

クスで、Source タブが選択されてい

ることを確認します。

23. File name を入力するか、Browse ボタ

ンを使用して以前セットアップしたオ
ーディオ・エレメンタリ・ストリーム
（Sym1pid120.es）を探します。

 手順
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24. File type ドロップダウン・リストから

MPEG-2 audio を選択します。ファイ

ルのビット・レートは自動的に入力さ
れます。

25. Timing タブを選択します。エレメンタ

リ・ストリームは、以前に設定したス
トリーム長、つまり 120 秒間実行され

ることに注意してください。

26. PCR タブを選択します。Carry PCR チ
ェック・ボックスがオフになっているこ
とを確認します。

27. PCR PID フィールドに「33」と入力しま

す。これは PCR 情報を含む PID であ

り、ビデオ es、Carry PCR も含まれま

す。

28. OK を選択して、Add Program Stream
ダイアログ・ボックスを閉じます。

29. Next を選択します。

30. Event Information ダイアログ・ボックス

で、Event Information Tables (EIT) チェ

ック・ボックスを選択します。

31. Present チェック・ボックスが選択され

ていることを確認します。

32. Present Settings を選択します。
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33. Present Events ダイアログ・ボックス

で、Add を選択して、現在のイベント

情報、つまり、この放送の時間をセ
ットアップします。Event ダイアログ・

ボックスで、Status ドロップダウン・リ

ストから 4 (running) を選択します。

34. Start Time を 2008-08-28 10:20:00 AM
に設定します。

時間と日付は、各フィールドをハイラ
イトし、必要な値を入力することによ
り変更できます。 

35. Event Name に（「Tek World」 など）を

入力します。

36. Description に（「The future of Tek」 な
ど）を入力します。

37. Duration に（30 分（「00:30:00」）など）

を入力します。

38. Content/Component Type ドロップダウ

ン・リストから 257 (MPEG-2 video,
4:3 aspect ratio, ...) を選択します。

39. OK を選択して、Event ダイアログ・ボ

ックスを閉じます。

40. OK を選択して、Present Events ダイア

ログ・ボックスを閉じます。

41. Following チェック・ボックスが選択さ

れていることを確認します。

42. Following Settings を選択します。

43. Add を選択して、後続のイベント情

報、つまり、現在のイベントに続くイ
ベントをセットアップします。

44. Event ダイアログ･ボックスで、Event Id
フィールドに「1」と入力します。

45. Status ドロップダウン・リストから

1 (not running) を選択します。

46. Start Time を 2008-08-28 10:50:00 AM
に設定します。

47. Event Name に（Tek News など）を入

力します。
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48. イベントの Description に（All the latest
news from Tek など）を入力します。

49. Duration に（30 分（01:00:00）など）を

入力します。

50. Content/Component Type ドロップダウ

ン・リストから 257 (MPEG-2 video,
4:3 aspect ratio, ...) を選択します。

51. OK を選択して、Event ダイアログ・ボ

ックスを閉じます。

52. OK を選択して、Following Events ダイ

アログ・ボックスを閉じます。

53. Event Information ダイアログ画面で

Next を選択します。

54. Program Complete ダイアログ・ボック

スで、Finish を選択します。

トランスポート・ストリームの構造とコンテ
ンツの作成が完了しました。以上で、いく
つかのチェックを行って、ストリームが正
常にコンパイルされることを確認できるよ
うになりました。 

55. View > Available Bitrate を選択しま

す。

Available Bitrate のグラフで、ビット・レ

ートが必要なビット・レート（つまり、
124.128 Mbps）内に収まっていること

に注意してください。 

グラフ上の任意の点におけるビット・
レートを調べるには、その点をクリッ
クし、隣のテーブルから値を読み取
ります。 
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56. Available Bitrate のグラフを閉じます。

57. Multiplex > Start を選択して、多重化

を開始します。

58. Set TS Output File... ダイアログ･ボック

スで、新しい多重化トランスポート・
ストリームの名前として
「TestMux.mpg」を入力します（この新

規トランスポート・ストリームは他の
手順でも使用します）。

多重化の進捗状況はステータス・バ
ーの右側に表示されます。ウィンド
ウの水平方向のサイズが小さすぎ
る場合、進捗状況バーが非表示に
なることがあります。 

以上で、エレメンタリ・ストリームと構
造情報が 1 つに多重化され、

TestMux.mpg というトランスポート・ス

トリームが作成されました。 

59. この多重化の構造は、後で必要に
応じて呼び出したり、情報を追加し
たりできるよう、保存しておくことをお
勧めします。

60. File > Export... を選択します。

61. Export File ダイアログ・ボックスで、多

重化構造ファイルの名前
（TestMux.muxml など）を入力し、ファ

イルを保存する場所を選択します。
muxml という拡張子に注意してくださ

い。

62. File > Import を使用すると、いつでも

多重化構造ファイルを開いて、エレ
メンタリ・ストリームや構造情報を追
加することができます。
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トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）の使用

次の手順では、トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）アプリケーションのファイル解析モ

ードを使用して、トランスポート・ストリームをオフラインで調べます。手順では、「マルチプレクサの使用」で作成し

たトランスポート・ストリーム（TestMux.mpg）を使用します。

ライブ･データを解析するにはリアルタイム解析を使用します複数入力のモニタ(61 ページ)

1. トランスポート・ストリーム・コンプライ
アンス・アナライザを開くには、File >
Program > Tektronix MTS4000 >
Analyzers > TS Compliance Analyzer
の順に選択します。

Open File Analysis ダイアログ・ボック

スが自動的に開きます。表示されな
い場合は、TSCA Analysis ツールバー

の File Analysis を選択します。 

Open File Analysis ダイアログ･ボックスで、

Base Standard が DVB となり、また Region
が No Extensions になっていることを確認

します。 

2. サンプル・ストリーム（TestMux.mpg）
を探して、選択します。

Advanced Settings フィールドで、

Stream Bit Rate および Timestamp
Settings が右図のようになっているこ

とを確認します。 
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3. 解析が完了するまでには、しばらく
かかります。

4. Analysis タブを選択し、ナビゲーショ

ン・ビューおよび関連するビューを表
示します。

5. Programs タブを選択し、プラス記号

をクリックしてナビゲーション・ビュー
の各ノードを展開します。

詳細ビューで、Summary ビューと

Tests ビューが表示されていることを

確認します。 

トランスポート・ストリームのノードと
プログラムのノードが両方とも赤くな
っています。これは、そのストリーム
でエラーが発生し、現在もアクティブ
であることを示しています。 

6. トランスポート・ストリーム・ノードを
ハイライトします。Tests Summary 詳
細ビューの TR 101 290 タブで、test
1.5.a PMT がエラーを示しており、関

連する LED が赤くなっていることに

注意してください。
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7. テスト 1.5.a PMT をハイライトし、Tests
ツリーでコンテキスト・メニューから
View this test を選択します。

Tests タブのビューが表示されます。ナビ

ゲーション・ビューが展開され、エラーに
なったテストが表示されます。詳細ビュー
には、ハイライトされたテストに関連する
PID（この例の場合は、なし）が表示され

ます。さらに、ハイライトされたテストに関
するイベントのみを表示するようフィルタ
リングされたイベント・ログが表示されま
す。 

ログ・エントリにエラー情報があるかどう
かを検証します。エラー・レポートでは
525 ms という継続期間を参照しているこ

とに注意してください。これは、PMT セク

ションの反復レートです。525 ms は、以前

に作成したサンプル・ストリームで設定し
た値です。 
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8. ナビゲーション・ビューで 1.5 PMT
(Timer) テストをハイライトし、コンテキ

スト・メニューから Edit Parameters を
選択します。

9. Edit Parameters ダイアログ･ボックス

で、このストリームに対して PMT
section maximum repetition interval が
500 ms に設定されています。このス

トリームの反復率（525 ms）がこの値

を超えているため、エラーとしてレポ
ートされています。ただし、Edit
Parameters ダイアログ・ボックスに表

示されている最大および最小の反
復レートを調べると（マウス・ポインタ
を値フィールド上に置き、ツール・チ
ップを参照する）、525 ms というレー

トが、DVB 規格で推奨されている範

囲（40 ms ～ 25000 ms）内にあること

が分かります。
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PES Analyzer の使用

各エレメンタリ・ストリーム（ビデオ、オーディオ、および補助データを含む）は、パケット化エレメンタリ・ストリーム
（PES）としてまとめられます。ここで特に注目すべき点は、トランスポート・ストリーム内の各 PES パケットに関連付

けられているヘッダです。このヘッダには、含まれているエレメンタリ・ストリームに対応するデコード・タイムスタン
プとプレゼンテーション・タイムスタンプ（DTS と PTS）が含まれています。これらのタイムスタンプにエラーがある

と、極端な場合には受信側でリセットまたはピクチャの静止といった問題が発生します。

1. PES Analyzer を開くには、Start > All
Program > Tektronix MTS4000 >
Analyzers > PES Analyzer の順に選

択します。

2. File > Open を選択します。トランスポ

ート・ストリームを探して、開きます。
たとえば、「マルチプレクサの使用」

で作成した TestMux.mpg ファイルを

使用します。

解析の進行状況が、ステータス・バ
ーとイベント・ログに表示されます。
解析が完了すると Program Structure
ビューが表示されます。この例で
は、ストリームで 1 つのプログラムを

伝送し、そのプログラムには 1 つの

ビデオ・エレメンタリ・ストリームと
1 つのオーディオ・エレメンタリ・スト

リームが、それぞれ PID 33 と 34 とし

て含まれていることが分かります。 
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3. Program Structure ビューでビデオ・ス

トリームを選択します。虫めがねアイ
コンは、そのストリームが選択されて
いることを示します。

4. View メニューで各ビュー・オプション

（つまり、Event Log、Hex、
Interpretation、および PTS/DTS Timing）
を開きます。それぞれのアクションに
より、PES Analyzer ウィンドウに新し

いビューが開きます。ウィンドウ内に
ビューをタイル表示するには、
Window > Tile オプションを使用しま

す。

ステータス・バーの上にあるスライ
ダ・バーを使用すると、PES ストリー

ム内の任意のパケットに移動できま
す。パケットには、ファイル内のそれ
ぞれに位置に応じて、PID 内に番号

が付けられています。スライダ・バー
には、現在のパケットのパケット番
号と PID が表示されます。 

Packet Hex View： 

このビューでは、PES に含まれる各バイ

トを調べることができます。 

■ 左の列の 4 桁の数値は、その行の

最初のバイトのアドレスです。

■ マゼンタで表示されているバイトは、
PES パケット・ヘッダであることを示し

ています。このヘッダは、Packet
Interpretation ビューにグラフィック形

式で表示することができます。
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Packet Interpretation View： 

このウィンドウでは、現在選択されている
パケットのヘッダを解釈してグラフィック
形式で表示します。ヘッダのサイズは、
パケットの内容によって異なります。 

PTS/DTS View： 

このビューには、選択したストリームのタ
イミング解析が表示されます。X 軸には

ストリームの継続期間が秒単位で表示さ
れます。Y 軸には DTS の予想値と実際

値の差が表示されます。垂直の青い線
は、アクセス・ユニットごとの PTS と DTS
の差を表します。その他のアクセス・ユニ
ットについての情報は、サイド・パネルに
表示されます。 

準拠しているストリームの場合は、0 ms
の Y 軸上に各 DTS が表示されます。エ

ラーがあるストリームの場合は、通常、
階段状に表示されます。 

グラフを拡大縮小するには、ツール・バ
ーの虫めがねを選択し、ビューをクリック
します。このウィンドウの下部にあるスラ
イダは、表示されているパケットの、ファ
イルの残りの部分との相対的な位置関
係を示します。 
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T-STD Buffer Analyzer の使用

T-STD Buffer Analyzer アプリケーションは、仮想的なトランスポート・ストリーム・システム・ターゲット・デコーダでの

バッファの動作を、ISO/IEC 13818-1 の仕様に合わせてモデリングします。ビデオ、オーディオ、およびシステム制御

の各ストリームを処理することができます。解析結果は、時間に沿ったバッファ容量のグラフ、および例外と注目
すべきイベントのログとして表示されます。バッファ・モデルに適合していないと、フレームが静止したり受信側のリ
セットが発生することがあります。

1. T-STD Buffer Analyzer を開くには、
Start > Program > Tektronix MTS4000
> Analyzers > Buffer Analyzer の順に

選択します。

2. 設定内容を確認するには、View >
Settings を選択します。

Settings ダイアログ・ボックスの

System タブで、MPEG2 Packet
Interpretation を選択し、Pre-Scan
Packets で All Packets を選択します。 
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3. Video タブで、Buffer Sizes, Automatic
と Data Transfer の Automatic を選択

します。

4. Audio タブで、Buffer Size の
Automatic を選択します。

5. Settings ダイアログ・ボックスを閉じ

ます。
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6. 解析するファイルを File > New の順

に選択します。

7. MPEG ファイルを探して、開きます。

たとえば、「マルチプレクサの使用」

で作成した TestMux.mpg ファイルを

使用します。

開くとすぐに、別のファイル選択ダイ
アログ・ボックスが開きます。このダ
イアログ・ボックスでは、バッファ・モ
デル結果（BMR）ファイルに名前を付

けて開きます。このファイルには、こ
れ以降の解析結果が保存されま
す。 

デフォルトの名前を受け入れ、ファイ
ルを開きます。 

プログラムにより初期解析が実行さ
れ、ストリーム・リストの作成と平均ト
ランスポート・レートの計算が行われ
ます。ストリーム・リストには、ファイ
ル内のプログラムとエレメンタリ・スト
リームがすべて表示されます。この
セッションではリスト内のすべてのス
トリームに対してまだ解析が行われ
ていないため、すべてのストリーム
に Unprocessed という表記がつきま

す。 

8. トランスポート・ストリームのコンテキ
スト・メニューから Process Streams
を選択して、ストリームの処理を開
始します。

解析の進捗がステータス・バーに表
示されます。 
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9. PID 33 をハイライトし、コンテキスト・

メニューから All Buffers を選択しま

す。

1 つのビデオ・エレメンタリ・ストリー

ムに関して、PID Event Log、Video
Transport Buffer、Video Multiplex
Buffer、および Video Elementary Buffer
の各ウィンドウが表示されます
（Stream List ウィンドウは最小化され

ています）。 

10. 結果ウィンドウを並べて表示するに
は、Window > Tile を選択します。

PID イベント・ログ： 

次の 2 つのイベント・ログ、初期解析

中に発生する高レベル・イベントを表
示するグローバル・イベント・ログ
（View > Global Event Log）と、処理さ

れた PID ごとのイベントを表示する

PID イベント・ログ（View > PID Event
Log）を開くことができます。 

以下で説明するバッファ・グラフ・ビュー
には、次の機能があります。 

■ ツール・バーの虫めがねアイコンを
使用して、選択したグラフを拡大縮
小できます。倍率値は、Reset Zoom
ツール・バー・ボタンでリセットできま
す。

■ 開いているすべてのグラフを、個別
に表示したり操作することがきます。
現在選択されているビューとすべて
のビューを同期させるには、Options
> Synchronize Views を使用します。

■ 赤色の Y 軸の線は、0% および 100%
の限界を示しています。

 

マルチプレクス・バッファ／メイン・バッフ
ァ： 

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリン
グ結果が表示されます。オーディオ・スト
リームおよびシステム制御ストリームに
対しては、メイン・バッファの結果が表示
されます。タイトル・バーにはストリーム・
タイプが表示されます。 
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ビデオ・トランスポート・バッファ： 

このビューには、ビデオ・ストリーム、オ
ーディオ・ストリーム、またはシステム・コ
ントロール・ストリームに対するトランスポ
ート・バッファのモデリング結果が表示さ
れます。 

ビデオ・エレメンタリ・バッファ： 

このビューには、該当するビデオ・エレメ
ンタリ・ストリームのみが表示されます。 

11. View > Trace を選択して、トレース・ロ

グを表示します。

トレース・ログを使用すると、Buffer
Analyzer により作成されたメッセー

ジ・ログを解析できます。これらのロ
グは、内部処理、特にビデオ・ストリ
ーム・タイプを詳細に解析するのに
役立ちます。トレース・ビューには、
関心のある特定のメッセージ・タイプ
に絞り込むためのフィルタリング機
能が備わっています。 
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ES Analyzer の使用

ES（エレメンタリ・ストリーム）Analyzer アプリケーションは、CODEC の MPEG-2 規格および H.263 規格への適合を調

べます。MPEG-2 オーディオ（ISO/IEC 13818 Part 3 および 7）、AC-3、および MPEG-4 AAC のオーディオ・デコードと波

形表示もサポートされています。

ES Analyzer は、ビデオ・ストリームおよびオーディオ・ストリームのさまざまな側面の解析に使用できる複合アプリ

ケーションです。このため、以下の手順では一部の解析画面へのアクセス方法を示しています。各画面の内容と
その意味の詳細については、『MTS4000 アナライザ・アプリケーション・ユーザ・マニュアル』を参照してください。

1. ES Analyzer を開くには、Start > All
Program > Tektronix MTS4000 >
Analyzers > ES Analyzer の順に選択

します。

2. 解析するファイルを File > Open で選

択します。

MPEG ファイルを探して、開きます。

たとえば、「マルチプレクサの使用」

で作成した TestMux.mpg ファイルを

使用します。 

3. ナビゲーション・ウィンドウの各ノード
を順にクリックして、Program 1 / PES
(PID 33)、MPEG 2 Video ブランチの

GOP（Group of Pictures）をハイライトし

ます。
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4. Picture Player タブを選択します。ピク

チャ・プレーヤのリモート・コントロー
ルが表示されます。

5. Show Information ボタンをクリックする

と、コントロール・バーが拡大しま
す。追加情報として、表示されている
ピクチャのファイル内の位置が示さ
れます。ステータス・バーには詳細
情報が表示されます。

6. コントロール・バーの再生ボタンをク
リックして、ストリームの再生を開始
します。

再生を停止すれば、他の GOP タブ

（GOP And Picture、Slice And MB）を選

択して、そのフレームの特性を調べ
ることができます。 

7. たとえば、Slice And MB タブで

Picture Display を選択します。このピ

クチャは、ピクチャ・プレーヤのピク
チャに対応します。

8. Picture Display の右側にある Show
MV をクリックします。B および P フレ

ームでは、モーション・ベクトルは、ピ
クチャに重なって表示される色付き
矢印として表示されます。
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さらに、マウスをピクチャのマクロブロッ
ク上に置くと、ピクチャを構成しているマ
クロブロックの特性を表示できます。 

9. Previous Frame ボタンおよび Next
Frame ボタンを使用すると、ストリー

ム内を前後に移動して、モーション・
ベクトルを比較できます。

同様の方法で、オーディオ・ストリームの
特性も調べることができます。 

10. ナビゲーション・ウィンドウの各ノード
を順にクリックして、Program 1 / PES
(PID 34)、MPEG 1 Audio ブランチの

GOP（Group of Pictures）をハイライトし

ます。

オーディオ・コントロール・バーを使
用すると、オーディオ・トラックを確認
できます。出力を聴取するには、ヘ
ッドフォンを使用する必要がありま
す。 
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TSCA FlexVuPlus™ ディスプレイ

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）で、FlexVuPlus™ を使用すると、解析詳細ビューか

ら最大 4 つビューを選んで一緒に表示し、基本的なトランスポート・ストリームのモニタや詳細な診断モニタを容易

に行うことができます。

ここでは、説明の便宜上、現在表示され
ているすべての FlexVuPlus パネルをいっ

たん閉じるものとします（各パネル右上
隅の X をクリックします）。 

これは必須ではありませんが、こうして
おけば、各パネルを配置する手順が理
解しやすくなります。これ以降は、
FlexVuPlus の各パネルを番号順に説明し

ます。 

パネル 1 のセットアップ 

1. Analysis タブをクリックし、次に Tests
タブをクリックします。

すべての詳細ビューの右上隅に
FlexVuPlus のパネル選択ボタンがあ

ります。このボタンを使用して、選択
した FlexVuPlus パネルに詳細ビュー

の複製を表示できます。 

2. Test Summary ビューで FlexVuPlus パ
ネル選択ボタンを使用して、このビュ
ーをパネル 1 に複製します。
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3. これで、FlexVuPlus のパネル 1 にテ

スト・サマリ・ビューが表示されます。

パネル 2 のセットアップ 

4. Analysis タブをクリックし、次に

Programs タブをクリックします。

5. Thumbnails ビューで FlexVuPlus パネ

ル選択ボタンを使用して、このビュー
をパネル 2 に複製します。
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6. これで、FlexVuPlus のパネル 2 にサ

ムネイル・ビューが表示されます。

パネル 3 のセットアップ 

7. Analysis タブをクリックし、次に Tests
タブをクリックします。

8. Test Failures ビューで FlexVuPlus パ
ネル選択ボタンを使用して、このビュ
ーをパネル 3 に複製します。
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9. これで、FlexVuPlus のパネル 3 にテ

スト・エラー・ビューが表示されます。

この例では 3 つのパネルしか使用してい

ないので、サムネイル・ビューを拡大し、
FlexVuPlus™ の右側全体に表示できま

す。 

パネルの垂直方向拡大ボタンを選択し
て、パネル 2 を縦方向に拡大できます。 

同様に、パネルを横方向に拡大するに
は、パネルの水平方向拡大ボタンをクリ
ックします。 

10. パネル 2 を拡大して、総合的な

FlexVuPlus の基本的なモニタ・ビュー

のできあがりです。

このビューでは次の項目をすぐに確認できます。

■ テスト・サマリ・ビュー（FlexVuPlus パネル 1）- 失敗したテスト

■ テスト・エラー・ビュー（FlexVuPlus パネル 3）- 直近に失敗したテスト

■ サムネイル・ビュー（FlexVuPlus パネル 2）- ビデオ・コンテンツを配信中のエレメンタリ・ストリーム
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複数入力のモニタ

MTS4000 型システムは、トランスポート・ストリーム・コンプライアンス・アナライザの複数のインスタンスを使用し

て、（別個の 10 G または PC の NIC ポート上の）複数のトランスポート・ストリームをモニタすることが可能です。

1. トランスポート・ストリーム・コンプライ
アンス・アナライザを開くには、File >
Program > Tektronix MTS4000 >
Analyzers > TS Compliance Analyzer
の順に選択します。

TSCA Analysis ツールバーの Real-
time Analysis... を選択します。 

2. Select Real-time Interface ダイアログ画

面で、Interfaces プルダウン・メニュー

から使用可能な入力を選択します。

この例では、TS コンプライアンス・ア

ナライザ・アプリケーションのこのイ
ンスタンスによるモニタに、ASI-3 入
力が選択されています。 

選択肢は、使用できるオプション入
力によって異なります。 
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3. トランスポート・ストリーム・コンプライ
アンス・アナライザのインスタンスを
もう 1 つ開きます。File > Program >
Tektronix MTS4000 > Analyzers > TS
Compliance Analyzer の順に選択しま

す。

TSCA Analysis ツールバーの Real-
time Analysis... を選択します。 

4. Select Real-time Interface ダイアログ画

面で、Interfaces プルダウン・メニュー

から使用可能な入力を選択します。

TS コンプライアンス・アナライザのこ

のインスタンスでは、ASI-4 入力をモ

ニタするように選択されています。 
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アクセサリ

スタンダード・アクセサリ

次の表は、MTS4000 型機器および MTS4SAV3 ソフトウェアに付属するスタンダード・アクセサリを示しています。

概要 部品番号 MTS4000 型 MTS4SAV3
適合性証明書 001-1180-XX ■ ■
ソフトウェア CD-ROM：MTS4000 アプリケーション・ソフトウェア・メディア 063-4385-XX ■ ■

Certificate Of Authenticity：Microsoft Windows 7 － ■

ソフトウェア DVD：MTS4000 オペレーティング・システムのリストア DVD 063-4387-XX ■

MTS4000 型および MTS4SAV3 型製品マニュアル CD-ROM
CD には、MTS4000 型とそのソフトウェア・アプリケーションをサポートするユ

ーザ・マニュアルが含まれています。

063-4386-XX ■ ■

MTS4000 型パッケージ・リファレンス 071-2969-xx ■

MTS4000 型および MTS4SAV3 型クイック・スタート・ユーザ・マニュアル 071-2970-xx ■ ■

補足情報シート、中国 RoHS 071-2185-xx ■ ■

ハードウェア・キー（ドングル）、USB － ■ ■

電源コード（以下のいずれか）

■ オプション A0 型 - 北米

■ オプション A1 型 - 欧州全域

■ オプション A2 型 - 英国

■ オプション A3 型 - オーストラリア

■ オプション A4 型 - 北米 240 V
■ オプション A5 型 - スイス

■ オプション A6 型 - 日本

■ オプション A10 型 - 中国

■ オプション A11 型 - インド

■ オプション A99 型 - 電源コードなし

－ ■
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オプションとアップグレード

オプション

次の表は、MTS4000 型で注文可能なソフトウェアおよびハードウェアのオプションを示しています。オプションに含

まれるアクセサリも記載されています。

Opt. 概要

ハードウェア・オプシ
ョン
（MTS4000 型のみ）

ASI マルチポート ASI インタフェースを追加。

最大 4 つの出力ポート。ポート 1 とポート 2 は RF カードおよび IP カ
ード用に予約されています。ポート 3 とポート 4 が使用可能です。

DS2  1 デュアル入力 DVB-S/S2 インタフェースを追加。2 ポートの QPSK/
8PSK または 1 ポートの 16APSK/32APSK 変調がサポートされます。

1 台の機器に対して最大 2 台のオプション DS2 型カードをご注文い

ただけます。

VS 8VSB インタフェースを追加（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

QB2 QAM B インタフェースを追加（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

IPTV 10／100／1000 Base-T RJ45 電気ポートの IPTV Gb イーサネット・イン

タフェースを追加（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

SX 1000 Base-SX 短波長 SFP 光ポートを追加。IPTV イーサネット・インタ

フェース用 LC コネクタ付き（マルチモード 850 nm）。

LX 1000 Base-LX 長波長 SFP 光ポートを追加。IPTV イーサネット・インタ

フェース用 LC コネクタ付き（シングルモード 1310 nm）。

ZX 1000 Base-ZX SFP 光ポートを追加。IPTV イーサネット・インタフェー

ス用 LC コネクタ付き（シングル・モード 1550 nm）。

10GS 10GBase-SR デュアル・オプティカル・ポートの 10 Gbps NIC を追加。

短距離用 SFP+ モジュール（850 nm）を含む。

1 オプション S2 型（シングル入力 DVB-S/S2 カード）の販売は終了しており、オプション DS2 型（デュアル入力 DVB-S/S2 カード）によって置き換えられま

した。
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Opt. 概要

ソフトウェア・オプショ
ン

注： MTS4SAV3 型の
場合に限り、これらの
ソフトウェア・オプショ
ンのうち少なくとも
3 つを注文する必要
があります。

TCMP
（MTS4SAV3 型のみ）

リアルタイム（IP インタフェースのみ）および事後解析に対応したト

ランスポート・ストリーム・コンプライアンス・アナライザ、カルーセ
ル・アナライザ、TS カッタ、および MPEG プレーヤを追加。

GEN マルチプレクサ、MPEG Player、Transport Stream Editor、ISDB-T
Remux、Make Seamless Wizard、Transport Stream Cutter、および Script
Pad を追加。

Tclips MPEG テスト・ストリーム・ソフトウェア・メディアを含みます。

ESS 標準 ES 解析機能を追加。全オプション付属の MTS4CC +
MPEG-2 ES Analyzer を含みます。

ESB 拡張 ES 解析機能を追加。MTS4EAV7 ベース・ソフトウェア（AVC）+
MPEG-2 ES Analyzer を含みます。

ESE 拡張 ES 解析機能を追加。全オプション付属の MTS4EAV7（HEVC を
含む）+ MPEG-2 ES Analyzer を含みます。

VQ ビデオ・クオリティ・ソフトウェア（シングル・エンド）を追加。全オプシ
ョン付属の VQS1000 を含みます。

PQ ピクチャ品質解析ソフトウェアを追加（シングル・エンドおよびダブ
ル・エンド）。オプション IP 型付属の PQASW を含みます。

PB PES Analyzer および T-STD Buffer Analyzer を追加。

CA CEA608、CEA708、SCTE20/21 用のクローズド・キャプション・アナライ

ザを追加。CA モードにロックされた MTS4EAV7 を含みます。

ソフトウェア・パッケー
ジ・オプション
（MTS4000 型のみ）

430 スタンダード・アクセサリ：Player、マルチプレクサ、および Tclips テス

ト・ストリーム、PES Analyzer および Buffer Analyzer、全オプション付

属の MTS4EAV7（HEVC を含む）、MPEG-2 ES Analyzer。

MTS4KUP アップグレード・キット

MTS4000 型 または MTS4SAV3 型テスト・システムの購入後に機器およびソフトウェアの機能を拡張できるように、

MTS4KUP アップグレード・キットが用意されています。キットは、ソフトウェア、ハードウェア、またはその両方を含

む場合があります。

機器へのハードウェアの取り付けは認定技術者が行う必要があります。
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Opt. 概要

MTS4KUP
hardwareupgrades
（MTS4000 型のみ）

ASI マルチポート ASI インタフェース。

最大 4 つの出力ポート。ポート 1 とポート 2 は RF カードおよび IP カ
ード用に予約されています。ポート 3 とポート 4 が使用可能です。

DS2  1 デュアル入力 DVB-S/S2 インタフェースでは、2 ポートの QPSK/8PSK
または 1 ポートの 16APSK/32APSK 変調がサポートされます。1 台の

機器に対して最大 2 台のオプション DS2 型カードをご注文いただけ

ます。

VS 8VSB インタフェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

QB2 QAM B インタフェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

IPTV 10／100／1000 Base-T RJ45 電気ポートの IPTV Gb イーサネット・イン

タフェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれま

す。

SX 1000 Base-SX 短波長 SFP 光ポート、IPTV イーサネット・インタフェー

ス用 LC コネクタ付き（マルチモード 850 nm）。

LX 1000 Base-LX 長波長 SFP 光ポート、IPTV イーサネット・インタフェー

ス用 LC コネクタ付き（シングルモード 1310 nm）。

ZX 1000 Base-ZX SFP 光ポート、IPTV イーサネット・インタフェース用 LC
コネクタ付き（シングル・モード 1550 nm）。

10GS 10GBase-SR デュアル・オプティカル・ポートの 10 Gbps NIC。短距離

用 SFP+ モジュール（850 nm）を含む。

1 オプション S2 型（シングル入力 DVB-S/S2 カード）の販売は終了しており、オプション DS2 型（デュアル入力 DVB-S/S2 カード）によって置き換えられま

した。
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Opt. 概要

MTS4KUP
softwareupgrades

TCMP
（MTS4SAV3 型のみ）

リアルタイム（IP インタフェースのみ）および事後解析に対応したト

ランスポート・ストリーム・コンプライアンス・アナライザ、カルーセ
ル・アナライザ、TS カッタ、および MPEG プレーヤを追加。

GEN マルチプレクサ、MPEG Player、Transport Stream Editor、ISDB-T
Remux、Make Seamless Wizard、Transport Stream Cutter、および Script
Pad。
Tclips MPEG テスト・ストリーム・ソフトウェア・メディアを含みます。

ESS 標準 ES 解析。全オプション付属の MTS4CC + MPEG-2 ES Analyzer
を含みます。

ESB 拡張 ES 解析。MTS4EAV7 ベース・ソフトウェア（AVC）+ MPEG-2 ES
Analyzer を含みます。

ESE 拡張 ES 解析。全オプション付属の MTS4EAV7（HEVC を含む）+
MPEG-2 ES Analyzer を含みます。

VQ ビデオ・クオリティ・ソフトウェア、シングル・エンド。全オプション付
属の VQS1000 を含みます。

PQ ピクチャ品質解析ソフトウェア、シングル・エンドおよびダブル・エン
ド。オプション IP 型付属の PQASW を含みます。

PB PES Analyzer および T-STD Buffer Analyzer。
V3 既存の MTS4SA バージョン 2 から MTS4SAV3 へのアップグレード

CA CEA608、CEA708、SCTE20/21 用のクローズド・キャプション・アナライ

ザを追加。CA モードにロックされた MTS4EAV7 を含みます。
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アクセサリ  
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MTS4000 型のシステム・リカバリ

MTS4000 システム・ソフトウェアに問題が生じた場合は、このセクションの手順に従って、システムを出荷時のデフ

ォルトのインストレーションと設定に戻します。

完全なシステム・リカバリを行うには、Windows オペレーティング・システムのリストアと MTS4000 型 MPEG テスト･

システムの再インストールが必要です。

システム・リカバリは 1 台目のハード・ディスク（C:）に影響しますが、2 台目のハード・ディスク（D:）には影響しませ

ん。

注： 交換用ディスクとして当社にご注文のハード・ディスク・ドライブに交換した後でソフトウェアをリストアする場合
は、ハード・ドライブ交換キットに付属の指示書に従ってください。

オペレーティング・システムのリストア

機器のオペレーティング・システムのリストアは、機器のハード・ディスク・ドライブ上のファイルか、またはその機
器のリストア DVD から行います。推奨されるリストア方法は、ハード・ディスクのリストア・ファイルを使用することで

す。

注意： データを失わないように、ハード・ディスクに保存した重要なユーザ・ファイルはすべてバックアップしてくだ
さい。このオペレーティング・システムのリストア手順は、1 台目のハード・ディスク（C:）を再フォーマットします。こ
れによりユーザがインストールしたファイルやアプリケーションはすべて消去されます。2 台目のハード・ディスク
（D:）には影響しません。

Windows が起動しない場合は、前回正常起動時の構成を使用して起動できる場合があります。

問題を避けるために、機器で使用する Windows は、Tektronix から特別に提供されているバージョン以外の
Windows と置き換えないようにしてください。Windows のバージョンは、本機器用に特別に構成されています。他の
バージョンの Windows では適切に動作しません。

機器のハード・ディスクからオペレーティング・システムをリストアする

本機器では、ハード・ドライブの別のパーティションにオペレーティング・システム・リストア用ファイルが含まれてい
ます。

1. 本機を再起動します。起動プロセスが実行されている間、画面上部に次のメッセージが表示されます。

Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager

2. Acronis True Image Tool が開くまで、F5 キーを繰り返し押します。メッセージが表示されてから機器が通常どお

り起動するまでに 5 秒ほどかかります。Acronis アプリケーションが起動しない場合は、本機の電源を一度切っ

てから入れ直し、再度同じ手順を実行してください。

3. Recover（回復）をクリックします。

4. Confirmation ダイアログ・ボックスで、Yes をクリックして本機のオペレーティング・システムをリストアします。リ

ストアせずにプロセスを終了するには、No をクリックします。リストア・プロセスには約 30 分ほどを要します

が、実際にかかる時間は機器の設定によって異なります。

5. メッセージが表示されたら、機器のシャットダウンか再起動を行います。

6. MTS4000 システム・アプリケーションをインストールします。
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OS リストア DVD を使用してオペレーティング・システムをリストアする

機器のシステム・ソフトウェアをリストアするには、MTS4000 型機器に付属する MTS4000 型 MPEG テスト・システ

ム・オペレーティング・システム・リストア DVD（063-4387-XX）が必要です。

1. オペレーティング・システム・リカバリメディアのディスク 1 を機器の DVD ドライブに挿入し、ドライブのドアを閉

じます。

2. 機器を再起動します。

機器が DVD から再起動しない場合は、次のようにして再起動します。

■ ブート・プロセスで、ブート・ドライブのメニューが表示されるまで、F11 ファンクション・キーを繰り返し押し

ます。

■ CD/DVD をブート・デバイスとして選択し、Enter キーを押します。これで機器が DVD からブートします。

注： 必要な場合、キーボードの矢印キーを使用して、必要なリストア・オプションを選択します。

3. メッセージが表示されたら、Recover the original system installation を選択し、Enter キーを押します。

4. Enter キーを押してインストールを続けます。リストア・プロセスが始まります。

注： このプロセスには時間がかかります。ファイルをコピーする最初の 10 分間、進捗バーは進みません。

注： 表示される指示に従ってください。この手順の中でディスクの交換が必要となります。

DVD を挿入するたびに、DVD の作動インジケータの点滅が終わるまで待ってから、OK または Retry を押してく
ださい。点滅が終わるまで待たないと、インストールを一時中断するためのポップアップが表示されます。そ
の場合は OK を選択します。

5. Acronis のリストア・プロセスが完了したら、リストア・ディスクを取り出します。

6. メッセージが表示されたら、再起動かシャットダウンを選択して OS のリストア・プロセスを終了します。機器が

再起動するか、その電源が切れます。

7. Windows のメッセージが表示されたら、Restart Now を選択して機器を再起動すると、すべてのデバイス・ドライ

バのインストールが完了します。

8. MTS4000 システム・アプリケーションをインストールします。

MTS4000 システム・アプリケーションのインストール

MTS4000 システム・アプリケーションのインストール手順は、スタンドアロンのインストール手順と同様です。

MTS4000 型プラットフォームに MTS4000 アプリケーションをインストールするには、インストール手順で Install on
MTS4000 Platform（MTS4000 型プラットフォームへのインストール）を選択して、インストールを続けます。
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MTS4000 アプリケーションのインストール後に、ソフトウェア・ライセンス・キーを回復する必要があります。このこと

は、スタンドアロンのインストール手順に説明されています（MTS4SAV3 型スタンドアロン・システムの設置(6 ペー

ジ)を参照）。
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ユーザ・メンテナンス

このセクションでは、MPEG テスト・システムの一般的な注意事項と保守の手順について説明します。

■ 「予防保全」では、クリーニングの手順について説明します。

■ 「問題が発生した場合」では、起動エラーのトラブルシューティングのヒントをいくつか示します。

■ 「修理のための機器の返送」では、機器を梱包して輸送するための手順を示します。

一般的な注意事項

機器は、厳しい気候条件から保護する必要があります。本製品は防水性を備えてはいません。

注意： スプレーや液体、溶剤に接触させないでください。機器が破損する可能性があります。

化学薬品の洗浄剤を使用しないでください。機器を損傷する恐れがあります。ベンゼン、トルエン、キシレン、アセ
トンまたはこれに類似する溶剤を含有する化学薬品を使用しないでください。

予防保全

年に一度、電気的な性能をチェックし、機器の確度を検証（校正）する必要があります。

予防保全は、主に定期的なクリーニングによって実現されます。定期的にクリーニングすることにより、機器が故
障しにくくなり、信頼性が高まります。動作環境に基づき、必要に応じて機器をクリーニングする必要があります。
コンピュータ室のような条件に比べると、汚れた条件下ではより頻繁にクリーニングする必要があります。

外部のクリーニング

機器の外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れが落ちな
い場合は、75% のイソプロピル・アルコール溶剤を染み込ませた布または綿棒を使用してください。コントロール

やコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちます。機器のどの部分にも研磨剤は使用しないでく
ださい。

注意： 外部のクリーニング時に機器の内部を濡らさないように、布または綿棒が湿る程度の量の溶剤のみを使
用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。

フロント・パネルのオン／スタンバイ・スイッチは水拭きしないでください。機器のクリーニング中はスイッチを覆っ
てください。

キーボードのクリーニング

キーボードおよび内蔵トラッキング・デバイスの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブ
ラシを使用してください。コントロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちます。機器の
どの部分にも研磨剤は使用しないでください。

注意： 外部のクリーニング時にキーボードや内蔵トラッキング・デバイスの内部が湿らないように、布または綿棒
が湿る程度の量の溶剤のみを使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純
水で洗い流してください。
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問題が発生した場合

このセクションでは、テスト・システムの使用中に発生する可能性がある問題について説明します。このセクション
では、性能の検査や調整に関連した具体的な問題は取り上げていません。このセクションで説明する MTS4000 型
システムの診断手順は、問題の切り分けに役立ちます。性能検査の手順については、『MTS4000 型製品マニュア

ル』CD-ROM に収録の『MTS4000 型仕様および性能検査テクニカル・リファレンス』（PDF ファイル）を参照してくださ

い。

起動時のセルフテストは、テスト・システムのアプリケーションを起動するために機器の電源を最初にオンにしたと
きに実行されます。これらの診断では、オペレーティング・システムとハードウェアが正しく動作することがチェック
されます。起動時のセルフテストでエラー・メッセージが発生した場合は、MTS4000 システム・ソフトウェアの起動を

妨げるシステム・エラーが存在する可能性があります。

以下の表は、オペレーティング・システムと周辺機器に関連するハードウェアの問題の症状と、考えられる解決策
のいくつかを示しています。

症状 考えられる原因と推奨される対応

機器の電源が入らない 電源コードが機器と電源に接続されていることを確認し
ます。
オン／スタンバイ・スイッチを押したときに機器に電気が
供給されること、およびファンが回転することをチェック
します。
電源から電力が供給されていることを確認します。
当社サービス受付センターにお問い合わせください。

機器の電源が入っても、起動時シーケンスが完了しな
い

機器がハード・ディスク・ドライブから起動していることを
確認します。

起動時のセルフテストが失敗する 当社サービス受付センターにお問い合わせください。

機器が、外部のモニタ、プリンタ、キーボードなどのアク
セサリを認識しない

アクセサリが適切に接続され、インストールされている
ことを確認します。
当社サービス受付センターにお問い合わせください。

オン／スタンバイ・スイッチで機器の電源が切れない Windows 7 のシャットダウン手順に従って機器の電源を

オフにしてみてください。それでも機器の電源が切れな
い場合は、タスク・マネージャを使用してタスクを終了し
ます。最後に、強制シャットダウン手順を試してくださ
い。オン／スタンバイ・スイッチを 5 秒間押したままにし

て、機器の電源を切ります。

ソフトウェアに関する問題

MPEG テスト・システムはソフトウェアがインストールされた状態で納品されます。ソフトウェアに問題があると思わ

れる場合は、テスト・システムのアプリケーション・ソフトウェアの問題と、インストールされている他のソフトウェア
の問題を区別するようにしてください。

ソフトウェアに関する問題の多くは、ソフトウェア・ファイルの破損または不足が原因になっています。ほとんどの
場合、ソフトウェアに関する問題を解決するための最も簡単な方法は、ソフトウェアを再インストールすることです
（MTS4000 型のシステム・リカバリ(69 ページ)を参照）。

ネットワークに問題があると思われる場合は、「ネットワークのトラブルシューティング(14 ページ)」を参照してくださ

い。
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ハードウェアに関する問題

ハードウェアの問題にはいくつかの原因が考えられます。このマニュアルの設置手順を読みなおして、機器を正
しく設置していることを確認してください。MTS4000 型システムにはユーザが保守できる部品はないため、ハードウ

ェアの問題が生じた場合は、当社サービス受付センターにお問い合わせください。

TSCAP P1 アイコンのリストア

うっかり TSCA P1 アイコンをデスクトップの Real Time Analysis フォルダから削除してしまった場合は、次の手順でア

イコンをリストアすることができます。

1. TS コンプライアンス・アナライザ・アイコンをデスクトップの Real Time Analysis フォルダか Start メニューからコピ

ーします。

2. アイコンを選択し、右クリックして Properties を選択します。

3. Shortcut タブを選択します。

4. Target フィールドでリンク先文字列の末尾に /p1 を追加します。リンク先文字列は次のようになります。

"C:\Program Files (x86)\Tektronix\mpeg\MTS4000\Apps\TSCA\bin\TSCA.exe" /p1

注： “ と /p1 の間には空白が必要です。

5. ショートカット・アイコンの名前の末尾に P1 を追加して名前を変えます。

修理のための機器の返送

機器を輸送用に再梱包する場合は、元の梱包材を使用してください。元の梱包材が手元にないか、使用に適して
いない場合は、当社営業所まで新しい梱包材を依頼してください。

1. 輸送用カートンを業務用ステープルまたは丈夫なテープで止めます。修理のために機器を返送する前に、サ
ービス受付センターに連絡して RMA（Return Material Authorization）番号を入手し、また詳細についてお問い合

わせください。

2. 機器を当社サービス受付センターに送る際には、次の情報を添えてください。

■ RMA 番号

■ 住所

■ 担当者の名前と電話番号

■ 機器のシリアル番号

■ 返却の理由

■ ご依頼の詳細な説明

3. 梱包箱の見やすい 2 箇所に、当社サービス受付センターの住所と返却先住所を記してください。
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